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Customer comments

Waters� Technical Communications department invites you to tell us of any 
errors you encounter in this document or to suggest ideas for otherwise 
improving it. Please help us better understand what you expect from our 
documentation so that we can continuously improve its accuracy and 
usability. 
We seriously consider every customer comment we receive. You can reach us 
at tech_comm@waters.com.

Contacting Waters

Contact Waters® with enhancement requests or technical questions regarding 
the use, transportation, removal, or disposal of any Waters product. You can 
reach us via the Internet, telephone, or conventional mail.

Waters contact information:

Contacting medium Information
Internet The Waters Web site includes e-mail 

addresses for Waters locations worldwide. 
Visit www.waters.com, and click Waters 
Division > Waters Division > Regional/Global 
Contacts.

Telephone and fax From the USA or Canada, phone 800 
252-HPLC, or fax 508 872 1990.
For other locations worldwide, phone and fax 
numbers appear in the Waters Web site.
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Empower Software

Intended use
Use the Waters Empower 2 Software for acquiring, processing, reporting, and 
managing your chromatographic information.

Safety information
See the operator�s guides of the instruments or devices associated with this 
software product for information on how to safely operate and maintain them.

Conventional mail Waters Corporation
34 Maple Street
Milford, MA 01757
USA

Waters contact information:

Contacting medium Information
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1 Introduction

This guide has been revised to describe Empower 2 Feature Release 5 
(FR 5) functionality, which includes Empower 2 service packs (SPA, 
SPB, SPC, SPD, and SPE) and feature releases (Feature Release 1, 
Feature Release 2, Feature Release 3, and Feature Release 4).
Throughout the guide, Empower configurations and Empower software 
will be referred to as follows:
� Empower Software for the generic Empower software product.
� Empower 2 FR 5 for Empower Build 2154 Feature Release 5.
This chapter describes Waters Empower 2 FR 5 software, the hardware 
and software needed to work with Empower 2 FR 5, and the types of 
chromatographic devices supported.
Contents
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Waters Empower software

The Waters® Empower� Software system includes these elements:
� Chromatographic instrumentation
� Chromatographic data acquisition and data processing computers 
� Empower software, a 32-bit data acquisition and management software 

application with advanced integrated database architecture
The system acquires, processes, reports, and manages chromatographic 
information. Empower offers easy-to-use technology and converts 
high-quality, accurate results into usable information while meeting security 
and regulatory compliance requirements. It is a complete chromatography 
and results management system that you can adapt to your individual 
chromatography requirements by using as many or as few Empower software 
capabilities as you require.

Typical system configurations

Empower can operate in the following configurations:
� Empower Personal workstation (see the figure �Typical Empower 

Personal workstation configuration� on page 1-3)
� Empower Workgroup (see the figure �Typical Empower Workgroup 

system configuration� on page 1-3)
� Empower Enterprise system (see the figure �Typical Empower 

Enterprise Client/Server configuration� on page 1-4)
� Empower database on a Sun Solaris server (see the figure �Typical 

Empower Enterprise Client/Solaris Server configuration� on page 1-5)
The following figure shows a typical Empower Personal workstation 
configuration.
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Typical Empower Personal workstation configuration

The following figure shows a typical Empower workgroup system 
configuration.

Typical Empower workgroup system configuration

The following figure shows a typical Empower Enterprise Client/Server 
configuration. 
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Typical Empower Enterprise Client/Server configuration
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The following figure shows a typical Empower Enterprise Client/Solaris 
Server configuration.

Typical Empower Enterprise Client/Solaris Server configuration
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Hardware and software requirements

The following tables describe the major subsystems, hardware, and operating 
system configurations that Empower software supports.  

Requirements for Empower Personal or client computers, LAC/E modules

Component Minimum
Operating system/
hardware

Windows® Vista Business with Service Pack 1 
(Personal) or
Windows Vista Enterprise with Service Pack 1 
(Client) or 
Windows XP Professional with Service Pack 2
Intel® Pentium® 4, 1.7 GHz CPU

Random access memory 
(RAM)

1 GB

Hard disk drive 8 GB
DVD drive Access to a DVD drive required
Monitor Required
Graphics capability sVGA video at 1024 × 768 × 16 bit color resolution
Printer Access to a printer required
Optional control card Waters Bus Laboratory Acquisition and Control/ 

Environment (busLAC/E�) card or 8-port serial 
card

Application software Empower software
Microsoft® Internet Explorer® 7.0

Network interface card Recommended for Personal 
Required for secondary PC and client
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Requirements for the primary computer

Component Minimum
Operating system/
hardware

Windows 2000 Server with Service Pack 4 or 
Windows 2000 Advanced Server with Service 
Pack 4 or
Windows Server 2003 R2 SP2
Intel Pentium III, 1 GHz CPU

Random access memory 
(RAM)

1 GB

Hard disk drive 3 hard drives
DVD drive Access to a DVD drive required
Backup device Recommended (optional)
Monitor Required
Graphics capability 1024 × 768 × 16 bit color resolution
Printer Access to a printer required
Application software Empower server software

Microsoft Internet Explorer 7.0
Network interface card 10/100 NIC

Requirements for the Windows database server

Component Minimum
Operating system Windows 2000 Server with Service Pack 4 or 

Windows 2000 Advanced Server or
Windows Server 2003 R2 SP2
Intel Pentium III, 1.2 GHz CPU

Random access memory 
(RAM)

1 GB

Hard disk drive 4 hard drives
DVD drive Access to a DVD drive required
Backup device Recommended (optional)
Hardware and software requirements 1-7



Monitor Required
Graphics capability 1024 × 768 × 16 bit color resolution
Printer Access to a printer required
Application software Empower server software

Microsoft Internet Explorer 7.0
Network interface card 10/100 NIC Required

Requirements for the Solaris database server

Component Minimum
Operating system Sun Fire V240 Server with 

UltraSPARC III Processor, running 
Solaris 10 

Random access memory 
(RAM)

2 GB

Hard disks 2 hard drives (3 recommended)
DVD drive Access to a DVD drive required
Backup device Recommended (optional)
Monitor Required
Graphics capability 1024 × 768 × 16 bit color resolution
Printer Access to a printer required
Server software Solaris 10

Oracle RDBMS 10.2.0.3
Network interface card 10/100 NIC Required

Requirements for the Windows database server (Continued)

Component Minimum
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Exception: The Empower 2 FR 5 installer gathers information about your 
system and compares your system settings to the minimum allowed 
specifications. If your system meets some but not all of the minimum 
specifications, the installation proceeds, but it will not be validated. If your 
system lacks any of the necessary requirements, the installation will not be 
allowed, and the installation procedure will stop and exit.

Devices supported by Empower

Empower can support these devices:
� Up to four busSAT/IN� modules through an I/O distribution box on the 

standalone Empower Personal workstations, Workgroups, clients, and 
LAC/E32 modules

� Multiple RS-232-based devices (such as gas chromatographs and 
detectors)

� Up to 14 IEEE-488-based devices using no more than 20 meters (65 feet) 
of cable in total, and no more than 4 meters (13 feet) of cabling between 
devices (see the table titled �Maximum cable lengths for IEEE-488 
devices� on page 1-10)

Requirements for Citrix® Presentation Server� Support

Component Minimum
Citrix Presentation Server 
operating system 

Windows 2000 Server with Service Pack 4 
(for Presentation Server 4.0)
Windows Server 2003 R2, Service Pack 2
(for Presentation Server 4.0 or 4.5)
Microsoft Internet Explorer 7.0

Citrix Presentation Server 
software

Presentation Server 4.0 or 4.5

Citrix ICA Client software ICA WIN32 Version 10.200.2650
Web Client software Web WIN32 Version 10.200.2650
Devices supported by Empower 1-9



� Ethernet devices

The following table lists the minimum firmware versions of the devices 
supported by Empower at the time of its release.
If you purchased an Empower system from Waters, a Waters technical service 
representative has already installed and configured your system.
Before you install an IEEE-488 device in the Empower system, verify that the 
firmware of the device is the minimum version listed in the following table.

Maximum cable lengths for IEEE-488 devices

Number of devices connected Maximum total cable length (meters)
1 4
2 6
3 8
4 10
5 12
6 14
7 16
8 18
Greater than 8 20

Supported IEEE-488 devices

Device type Device Supported firmware 
version1

Pumps Waters 600E Controller (CRT 
display), Fluid Handling Unit 
(FHU) = 600, 610, 600MS, or 
625

2.1

Waters 600E Controller [Silk 
(CRT display)], 
FHU = 600MS

2.1

Waters 600 Controller (LP/LCD 
display, AC transformer), FHU 
= 600 or 610

3.5
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Waters 600 Controller (LP/LCD 
display, DC power supply), FHU 
= 600 or 610

4.2

Waters 600S Controller 
(LP/LCD display, AC 
transformer), FHU = 616 or 626

4.2

Waters 600S Controller 
(LP/LCD display, DC power 
supply), FHU = 616 or 626

4.2

Waters 625 Controller [Silk 
(CRT display)], is not supported; 
runs if Silk is not uploaded

2.1

Waters PrepLC Controller 
2000/4000

3.1

Waters 1525 and 1515 pumps 2.02
Waters 1525μ and 1525EF 
pumps

2.11

Interfaces and 
Accessories

Waters Half-Size busLAC/E 
Card

Rev. A

Waters Temperature Control 
Module (TCM)

2.1

Waters Temperature Control 
Module II (TCM II)

3.0

Waters Pump Control Module 
(PCM)

2.2

Waters Pump Control Module II 
(PCM II)

3.0

Waters 1500 Column Heater 1.02
Detectors Waters 410 Refractive Index 

Detector
4.20

Waters 486 Tunable Absorbance 
Detector

4.1
4.2

Supported IEEE-488 devices (Continued)

Device type Device Supported firmware 
version1
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The following table lists the minimum firmware versions of the non IEEE-488 
devices, serial instruments, and Ethernet control instruments supported by 
Empower at the time of its release.

Waters 2410 Refractive Index 
Detector (appears as 410)

5.1

Waters 2414 Refractive Index 
Detector (2410 emulation mode)

1.0

Waters 2487 Dual λ Absorbance 
Detector

1.01

Waters 996 Photodiode Array 
Detector

Firmware 1.8 
Software 2.3

Waters 2996 Photodiode Array 
Detector

3.5

Autosamplers Waters 717plus Autosampler 3.1
Waters 2700 Sample Manager 2.2
Waters 2707 Autosampler 1.0

Systems Waters 2695 Separations 
Module

2.04

Waters 2695D Separations 
Module

2.04

Waters 2795 Separations 
Module

2.05

Waters 2796 Separations 
Module

2.11

1. You can find the firmware revision number on the instrument specification plate or front 
panel display.

Non IEEE-488 devices, serial, and Ethernet instruments

Device type Device Supported firmware 
version1

Detectors Waters 432 Conductivity 
Detector

Not controlled by 
Empower 

Supported IEEE-488 devices (Continued)

Device type Device Supported firmware 
version1
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Waters 470 Fluorescence 
Detector

Not controlled by 
Empower

Waters 474 Fluorescence 
Detector

2.02
�Scan Mode� and �Not 
Restricted� are not 
supported.
Connected to PC COM 
port or serial card. 
Not supported on 
busLAC/E.

Waters Capillary Ion Analyzer 
(CIA) Detector

Not controlled by 
Empower

Waters 2414 Refractive Index 
(RI) Detector

2.xx

Waters 2420 Evaporative Light 
Scattering Detector

1.00.1057 
(instrument driver)

Waters 2424 Evaporative Light 
Scattering Detector

1.20.3743

Waters 2465 Electrochemical 
Detector

1.00.1073
(instrument driver)

Waters 2475 Multi λ 
Fluorescence Detector

1.01.1065 (Equinox; 
instrument driver 
version)
2.01 (Ethernet; 
firmware version)

Waters 2489 UV/Visible Detector 1.30.1848
Waters 2998 PDA Detector 1.30.4967
Waters 3100 Mass Detector 1.30 (Windows XP)

1.31 (Windows XP or 
Windows Vista)

Non IEEE-488 devices, serial, and Ethernet instruments (Continued)

Device type Device Supported firmware 
version1
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Waters Single Quad (SQ) 
Detector

1.30 (Windows XP)
1.31 (Windows XP or 
Windows Vista)

Waters Triple Quad (TQ) 
Detector

1.30 (Windows XP)
1.31 (Windows XP or 
Windows Vista)

Waters ZQ� 2000 and ZQ 4000 
Mass Detectors

1.0
1.01 (J version)

Waters EMD1000 Mass Detector 1.0
Pumps Waters 1525 and 1515 Pumps 2.11

Waters 1525μ and 1525EF 
Pumps

2.11

Gas 
Chromatographs

A5890 and A5890S Gas 
Chromatographs

A.03.02
�S� designates 
instrument on serial 
card

6890 and 6890+ Gas 
Chromatographs

A.03.08

6890N Gas Chromatographs N.05.04
N.05.05

A6850 Gas Chromatographs A.03.03 
(for SN US00003200 
or lower; supported 
only when connected 
via an Equinox card)
A.05.04
(supported only when 
connected via LAN)

Headspace 
samplers

Agilent HS7694:
model G1289B
model G1290B

1.02b
1.05

Non IEEE-488 devices, serial, and Ethernet instruments (Continued)

Device type Device Supported firmware 
version1
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Agilent G1888A A.01.08
A.01.09

Controllers Agilent G1512A 
Agilent G2912A

4.3
A.02.01 (FW)

A7673 and A7673S 
Autosampler Controllers

4.3
�S� designates 
instrument on serial 
card
Dual tower 
autoinjections 
supported on serial 
card

Autosamplers Waters 2707 Autosampler 1.0
7683 Autosampler
7683B Autosampler

A.10.07
A.11.02

Systems Alliance Series 2695 
Separations module

3.00

Alliance Series 2795 
Separations module

3.00

Alliance Series 2796 
Bioseparations module

3.00

ACQUITY UPLC System:
� Sample manager (ACQ-SM)
� Binary solvent manager 

(ACQ-BSM)
� Detector (ACQ-TUV)
� Detector (ACQ-2996)
� Sample organizer (SO)
� Column manager (CM)
� Fluorescence detector (FLR)

1.10.130 (FW)
1.10.1494 (SW)

1.10.71 (FW)
1.10.1334 (SW)
1.10.1174 (FW)
4.00
1.10

Temperature control system 
(TCM II)

3.02

Non IEEE-488 devices, serial, and Ethernet instruments (Continued)

Device type Device Supported firmware 
version1
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A1100/1200-series control 
modules and components2:
� Pumps (isocratic, quaternary, 

and binary, with solvent 
switching)

� Autosamplers (standard and 
thermostatted)

� Column compartment (with 
column switching valve)

� VWD
� MWD (DAD) A
� MWD (DAD) B
� RID
� DAD (on Ethernet)
Restriction: These systems 
cannot be controlled using a 
serial connection.

A.06.02/06/B.01.06/
B.02.05
A.06.1x/B.06.1x

Interfaces and 
Accessories

Waters Pump Control Module II 3.05

Waters 1500 Column Heater 1.02
Waters SAT/IN Module 13.0 or 20.0

Supported only on 
busLAC/E

Non IEEE-488 devices, serial, and Ethernet instruments (Continued)

Device type Device Supported firmware 
version1
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Waters SAT/IN2 Module 13.0 or 20.0
�2� designates 
instrument on 
Equinox card
Unlike the case with 
the busSAT/IN, both 
channels on the 
SAT/IN2 must be 
configured in one 
system. 
Can be set as a dual 
tower instrument 
using the Run Sample 
user customized 
preferences page.
Connects to PC COM 
port or serial card.
Not supported on 
busLAC/E.

Waters e-SAT/IN Module 1.10.1015
Equinox Serial Interface Card 5.41
NI GPIB-ENET/100
NI-488.2

B.9
2.1

1. You can find the firmware revision number on the instrument specification plate or front 
panel display.

2. Empower software has been tested with the listed firmware versions of the Agilent software. 
Follow Agilent guidelines for firmware compatibility. For a list of supported modules, see the 
Agilent LC Overview topic in the Agilent online Help. (To access the Agilent online Help, 
press the F1 key while using the Instrument Method Editor for an Agilent instrument 
method.)

Non IEEE-488 devices, serial, and Ethernet instruments (Continued)

Device type Device Supported firmware 
version1
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2 Installing and configuring the 
hardware

This chapter tells you how to install and configure the hardware for the 
Waters Empower software system.
Contents

Topic Page
Preparing for Empower software 2-2
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Preparing for Empower software

For all configurations, except an Empower Personal workstation, a network is 
required in your facility so that the Workgroups and/or the Empower 
Enterprise system can function. Waters personnel do not run or install 
network cabling.
Tip: If your Waters technical service representative has already installed and 
configured the system for you, proceed to �Powering-on the system� on 
page 2-23.
Recommendation: Before installing any hardware or software, perform a full 
backup of your hard drives (see the instructions provided by the manufacturer 
of your computer).

Selecting the site

Locate the Empower system in a clean area, free from shock, vibration, and 
extremes of temperature and humidity.

Environmental requirements
The Empower system is designed to operate within the following temperature 
and humidity ranges:

� Temperature: 10 to 31°C (50 to 88°F)
� Humidity: 20 to 80% relative humidity, noncondensing, maximum wet 

bulb of 25°C and minimum dew point of 2°C
Acceptable temperature and humidity ranges vary according to the model of 
computer and printer.
Protect equipment from direct sunlight, heat registers, or air conditioning 
vents.

Bench space 
Allow sufficient bench space for the Empower Personal workstation, 
Workgroup, or client computers (keyboard, monitor, system unit, and printer) 
as recommended in the documentation supplied with the computer. You can 
place the computers on the lab bench or on a desktop near the 
chromatography instrumentation. The total bench space you require depends 
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upon the number of devices you plan to configure (pumps, detectors, 
autosamplers, eSAT/IN modules, and so on).

Cable lengths 
Arrange the components of your chromatographic system to minimize cable 
lengths. Use optimal cable lengths to ensure proper signal transmission. 
Maximum cable lengths are listed in the table on page 1-10.

Instrument arrangement
Make sure the ventilation slots on all instruments are not blocked. Allow at 
least 6 inches (15 cm) of space on all sides of each instrument to ensure 
adequate air flow.
For information on the best arrangement of your Empower system and 
connected instruments, consult your Waters technical service representative.

Installing and configuring computer systems

This section describes the process for installing and configuring the Empower 
computer systems and other components. 

Empower Personal workstation
The Empower Personal workstation supports these cards:

� A busLAC/E (IEEE-488 interface) card for connecting Waters 
IEEE-488 devices 

� An optional 8-port serial card for connecting 6890 GCs or other 
supported serial instruments

� A second network interface card for Ethernet instruments

To install and set up the Empower Personal workstation

1. Unpack and place the workstation in the desired location.

2. Attach the keyboard, mouse, and monitor to the workstation.

3. To install other computer peripherals such as a printer or optional tape 
drive, see the installation documentation supplied with the device.
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4. Ensure that the busLAC/E (IEEE-488 interface) card is installed in the 
workstation and is set up correctly (see �busLAC/E card� on page 2-5).

5. Connect the IEEE-488 chromatography instruments to the busLAC/E 
card in the workstation using the IEEE-488 cable (see �Connecting 
IEEE-488 chromatographic devices� on page 2-8).

6. Connect and configure the serial or Ethernet devices (see �Connecting 
non IEEE-488 chromatographic devices� on page 2-16).

7. Power-on the workstation (see �Powering-on the system� on page 2-23).

Empower Workgroup or Enterprise system
The Empower Workgroup or Empower Enterprise system consists of a server, 
one or more clients, and one or more LAC/E32 modules. Each computer in the 
Empower Enterprise system requires at least one network interface card.
Chromatographic devices in an Empower Enterprise system or workgroup are 
connected to the LAC/E32 module. The LAC/E32 module provides distributed 
acquisition for the Workgroup and Enterprise configurations including:

� Data acquisition
� Instrument control
� Remote access to instruments
� Remote data processing in Run and Report modes

To set up the Empower Enterprise system 

1. Unpack and place the server in the desired location.

2. Attach the keyboard, monitor, and mouse to the server.

3. To install other computer peripherals such as a printer or optional tape 
drive, see the installation documentation supplied with the device.

4. Ensure that the network interface card is installed in the server and is 
set up correctly (see �Network interface card for Ethernet instruments� 
on page 2-8). If you are using Ethernet instruments, ensure a second 
network interface card is present. If you are using serial instruments, 
ensure a serial card is present.

5. Set up the clients.
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To set up an Empower Enterprise client

1. Unpack and place the client computer in the desired location.

2. Attach the keyboard, mouse, and monitor to the computer.

3. Ensure that the network interface card is installed in the client and is 
set up correctly. 

4. Repeat step 1 through step 3 for each client in the Enterprise system.

5. Connect the client to the network.

6. Set up the LAC/E32 modules.

To set up a LAC/E32 module

1. Unpack and place the LAC/E32 module in the desired location.

2. Ensure that the network interface card is installed in the LAC/E32 
module and is set up correctly. 

3. Connect the LAC/E32 module to the network. 

4. Connect the chromatographic instruments to the LAC/E32 module. 

Optional interface cards
You can directly connect to the COM port on an Empower Personal 
workstation or an acquisition client without a busLAC/E card when you are 
acquiring data from a SAT/IN2 Module and a 474 Detector.

busLAC/E card

The busLAC/E card is a microprocessor-based interface card that transmits 
commands from Empower software to detectors, autosamplers, pumps, and 
other devices over the IEEE-488 and custom interfaces via an IEEE-488 cable. 
Data from the devices are transmitted through the busLAC/E card to the 
computer for analysis.
The Empower Personal workstation can use a busLAC/E card to function with 
Empower. Chromatographic devices can connect to the busLAC/E card. The 
busLAC/E card performs two primary functions:

� Acquires data from a detector and transmits the data to the computer
Installing and configuring computer systems 2-5



� Controls chromatographic devices
A maximum total aggregate data rate of 400 points per second applies to all 
detectors connected to the busLAC/E card per four systems per four projects, 
except in configurations including a PDA detector or configurations with a 
combination of LC and GC instrumentation. The following table describes the 
exceptions to the data rate for each instrument type.

Data rates for busLAC/E card connections

Instrument Data rate
busSAT/IN Maximum total aggregate data rate of 100 points per 

second for each busSAT/IN� (50 points per channel).
Split busSAT/IN Control of up to two split busSAT/INs (each channel 

resides in a separate system) for a total of four 
channels in four separate systems. Each channel will 
be at a maximum of 50 points per second. (The 
busSAT/IN channels can be split only when the 
busSAT/IN is connected to a busLAC/E.)

Gas 
Chromatograph

Maximum total data rate of 200 points per second for 
each 6890 GC system.
Maximum total data rate of 20 points per second for 
the control of two 5890 GC systems and 5 points per 
second on two additional LC systems.

PDA (Personal) Two systems allowed, each with a 996 or 2996 PDA 
detector running at 300-nm maximum range for each 
system, 1.2-nm resolution, and 5 spectra per second.
One 996 or 2996 PDA detector can be running at 
either half spectrum at 4.8-nm resolution and 5 
spectra per second, or half spectrum at 1.2-nm 
resolution and 1 spectrum per second, and three other 
LC systems can be running at a maximum aggregate 
data rate of 30 points per second.

PDA (Workgroup or 
Enterprise)

Two systems allowed, each with a 996 or 2996 PDA 
detector running at a 1000-nm combined range, 
1.2-nm resolution, and 10 spectra per second.
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8-port serial card

The 8-port serial card transmits commands from Empower to the serial 
instrument. Data from the chromatograph are transmitted to Empower for 
analysis through a single port on the 8-port serial card. 
The card has eight possible serial connections. Each instrument type requires 
one connection. The 8-port serial card can connect to the following supported 
instruments, with the restrictions as indicated:

� 5890S/7673S systems (maximum of four)
� 6890 instruments (maximum of four)
� 6890/SAT/IN2 systems (maximum of four)
� SAT/IN2 instruments (maximum of eight; to be used as four 

multi-channel systems)
Tip: �S� and �2� designate that the instrument is connected through the 8-port 
serial card.
To install the 8-port serial card in the computer, see the installation 
instructions provided with the 8-port serial card.
Restriction: Do not use the Equinox driver provided by Microsoft Windows. 
During the first power-up after installing the serial card, Microsoft Windows 
detects the new hardware and automatically installs a driver version for the 
Equinox card.
Requirement: You must update this driver to a supported version. See 
�Updating the Equinox driver� on page 7-2 for instructions.

Two-System 
Acquisition

When you perform a two-system acquisition (one 
system being a 600/717/486 and the other system 
being 2695/996 or 2695/2996), the maximum data 
rate for the 486-based system should be 2 points per 
second and for the 996- or 2996-based system, 5 
spectra per second, with 1.2-nm resolution and a 
wavelength range of 190 to 800 nm.

Data rates for busLAC/E card connections (Continued)

Instrument Data rate
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Network interface card for Ethernet instruments

A client, LAC/E32, and/or Personal workstation can use an additional network 
interface card (NIC) to communicate with Ethernet instruments (such as the 
e-SAT/IN or 2475 detector). You must assign an IP address to this network 
card (also called an instrument network card) so that it can assign IP 
addresses to your Ethernet instruments. To set the IP address, Empower 
software must first be installed on the client, LAC/E32, or workstation. Use the 
Configure DHCP tab of the Empower Node Properties page in Configuration 
Manager to configure the IP address. For details, see the Ethernet Instrument 
Getting Started Guide or see the topic �Configuring chromatographic 
instruments� in the Empower Help.

Connecting IEEE-488 chromatographic devices

Use this section to connect the IEEE-488 components of your chromatographic 
system to the busLAC/E card in an Empower Personal workstation or a 
LAC/E32 module.

busLAC/E card connections
The busLAC/E card connects to peripheral devices through two ports on the 
rear edge of the card as follows:

� IEEE-488 port � Used for connecting to IEEE-488-controlled devices 
such as these:
� Waters 2690/2695 Separations Module
� Waters 996/2996 PDA Detector
� Waters 717plus Autosampler
� Waters 2487 Dual λ Absorbance Detector

� I/O distribution port � Used for connecting to serial devices, such as the 
Waters busSAT/IN Module

Tip: For a complete list of devices supported by the Empower system, see 
�Devices supported by Empower� on page 1-9.
An IEEE-488 cable connects the 2690/2695 Separations Modules, 996/2996 
PDA Detectors, 2487 Absorbance Detectors, and other IEEE-488 devices to 
the busLAC/E card.
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An I/O distribution cable connects the I/O distribution box to the I/O 
distribution port of the busLAC/E card. Serial instruments and devices, 
including the busSAT/IN Module, connect to the busLAC/E card through the 
I/O distribution box.

busLAC/E card port connections

Empower software supports the use of one 996/2996 PDA Detector at a full 
data rate of 10 spectra/sec. At this rate, the software can support one 
additional chromatographic system with a data rate of 10 points/sec. If you 
use a 996/2996 PDA detector at half spectra or a data rate of 5 spectra/sec, you 
can run three additional chromatographic systems with an aggregate data 
rate of 30 points/sec.

Interface overview
The IEEE-488 bus is an instrument interface that connects devices using one 
communication protocol. In the Empower system, the IEEE-488 interface 
connects Waters IEEE-488 chromatography devices to the busLAC/E card.
The busLAC/E card is an instrument controller, assigning the role of active 
talker or listener to each attached device on the IEEE-488 bus. Each 
instrument designated as an active talker supplies information to the other 
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n 
devices on the IEEE-488 bus. Each device designated as a listener receives 
information from an active talker device. Only one active talker is allowed at a 
time, but several listeners can be active simultaneously.

Interface guidelines
According to IEEE-488 protocol specifications, use the following guidelines:

� Always keep all devices powered-on while your system is in use.
� The maximum number of devices that you can connect to form one 

interface system is 15 (14 instruments plus the busLAC/E card).
� The maximum total cable length connecting the devices and the 

busLAC/E card in one interface system is 2 meters (6.5 feet) multiplied 
by the number of devices, or 20 meters (65 feet), whichever is smaller 
(see the table titled �Maximum cable lengths for IEEE-488 devices� on 
page 1-10).

� The maximum cable length between two devices is 4 meters (13 feet).
� The minimum cable length between two devices is 1 meter (3.25 feet)

� Use addresses 2 through 29 for instruments.
Recommendation: Use IEEE addresses 9 and above, spacing the 
addresses by a difference of 2. Example: 9, 11, 13, and so on.
Tip: For details on setting IEEE-488 device addresses, see �Setting 
IEEE-488 device addresses� on page 2-13.

� While a system is active on the IEEE-488 bus, do not power-on or 
power-off any device on the bus.

Making cable connections
The Empower system supports the Waters IEEE-488 devices listed in the 
table on page 1-10.

To connect IEEE-488 devices

1. Connect the single-receptacle end of the IEEE-488 cable (supplied with 
the Empower system) to the busLAC/E card.

Caution: Cable lengths greater than the maximum values or less tha
the minimum values can cause IEEE-488 communication failures.
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Example of IEEE-488 cable connections

2. Connect the other end of the IEEE-488 cable (with the stackable 
connector for daisy-chaining additional instruments) to the IEEE-488 
connector on an instrument.

3. Use one end of another IEEE-488 cable to connect to the stackable 
connector on the first instrument. Connect the other end of the cable to 
the IEEE-488 port on the next instrument.

4. Repeat step 3 for each additional instrument, up to 14 IEEE-488 
instruments. See the table titled �Maximum cable lengths for IEEE-488 
devices� on page 1-10 for cable-length limitations.
Tip: The order in which you connect IEEE-488 devices to the busLAC/E 
card is not important. For example, you can connect the injector before 
or after the detector.

5. Ensure that all IEEE-488 cable connector screws are fastened 
finger-tight.
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Making device connections

PCM connections

The Waters Pump Control Module (PCM) is an IEEE-488 device that controls 
the 500-series pumps. Connect the PCM to the IEEE-488 bus as described in 
�Interface overview� on page 2-9.

TCM connections

The Waters Temperature Control Module (TCM) is an IEEE-488 device that 
regulates the temperature of as many as three column heaters. Connect the 
TCM to the IEEE-488 bus as described in �Interface overview� on page 2-9.

Pump connections

If you are using a 2690/2695, 600-series pump (Waters 600E, 616, 625 LC, 
626, 650E, ActION Analyzer, Delta Prep, and Prep LC), you can connect to the 
busLAC/E card through the IEEE-488 port or to other IEEE-488 devices in a 
stacked configuration (see �Interface overview� on page 2-9).
Requirement: If you are using a PowerLine�/Gradient version of software on 
your 600-series multisolvent delivery system, configure the controller 
software as a Gradient controller via the front panel keypad (not via Empower 
software). See the appropriate operator's guide for information on configuring 
the controller.

Injector connections

Detectors and system controllers that are not controlled by an Empower 
system (for example, 2690/2695, 600-series controller, and GC) require an 
inject-start trigger signal (contact closure) from the injector as each injection 
occurs. The inject-start trigger signal instructs detectors and system 
controllers to acquire data or run methods.
Waters autosamplers transmit the inject-start signal over the IEEE-488 bus 
or by trigger wire. If you connect a Waters 2690/2695, 717, or 717plus to an 
IEEE-488 interface, you need not make additional connections for an 
inject-start signal.
When under IEEE-488 control, the 2690/2695 Sample Management System, 
717, and 717plus Autosamplers transmit the inject-start signal directly over 
the IEEE-488 bus during data acquisition. All controlled devices are triggered 
simultaneously when an injection is made by these instruments. Trigger wires 
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are not required when all instruments in a chromatographic system are 
controlled over the IEEE-488 bus.
Requirement: Any instrument not controlled by Empower software requires 
an inject-start trigger wire connection.

Detector connections 

Detectors with an installed IEEE-488 interface can be connected directly to 
the busLAC/E card as described in �Interface overview� on page 2-9.

Setting IEEE-488 device addresses
You must set a unique address for each device connected on the IEEE-488 bus 
so that the busLAC/E card recognizes each device. Valid IEEE-488 instrument 
addresses are 2 through 29. Set the IEEE-488 addresses of the Waters 
instruments in your system through either the software or DIP switches.
Recommendation: Use IEEE addresses 9 and above, spacing the addresses by 
a difference of 2. Example: 9, 11, 13, and so on.

The following figure shows the arrangement of DIP switches on a DIP switch 
block (on the rear panel of a device).

Setting DIP Switches

Instrument IEEE-488 address set by
2487 detector Software (front panel of instrument)
486 detector Software (front panel of instrument)
717 autosampler Software (front panel of instrument)
717plus autosampler Software (front panel of instrument)
600-series controller:
RW 3D controller
600E and 650E systems (v. 3.0 or 
later)
616 and 626 systems (v. 4.2 or later)

DIP switches
Software (front panel of instrument)
Software (front panel of instrument)

410, PCM, TCM, and 996/2996 DIP switches (see the table titled 
�Settings for the Waters 600, 410, 
996, PCM, and TCM� on page 2-15)
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DIP switch block

Setting IEEE-488 addresses using software

To set an IEEE-488 address using software, set the address from the front 
panel of the device. See the operator's guide for a particular device for detailed 
instructions on setting the IEEE-488 address.

Scanning the IEEE-488 bus

After you set the IEEE-488 address for a device, the busLAC/E card must scan 
the IEEE-488 bus. To scan the IEEE-488 bus, see �Configuring 
chromatographic instruments� in the Empower Help.

Tip: For the LAC/E32 module with the WatersService, the busLAC/E card 
automatically scans the IEEE-488 bus on startup.

Setting IEEE-488 addresses using DIP switches

To set an address 

1. Ensure that no instruments are connected to the busLAC/E card.

2. Power-off the IEEE-488 device.

3. Using the DIP switches on the rear panel of the device (see the figure, 
above), set a unique IEEE-488 address for the device. 
Tip: Although there are 28 valid addresses (2 through 29), IEEE-488 
protocol allows up to 14 devices.
To set the IEEE-488 address for a Waters 600-series controller, 410 
detector, 996/2996 detector, PCM, or TCM, see the table below.
2-14 Installing and configuring the hardware



4. Power up the device.

Settings for the Waters 600, 410, 996, PCM, and TCM

IEEE-488 
address

DIP switch settings1

1 2 3 4 5
2 OFF ON OFF OFF OFF
3 ON ON OFF OFF OFF
4 OFF OFF ON OFF OFF
5 ON OFF ON OFF OFF
6 OFF ON ON OFF OFF
7 ON ON ON OFF OFF
8 OFF OFF OFF ON OFF
9 ON OFF OFF ON OFF
10 OFF ON OFF ON OFF
11 ON ON OFF ON OFF
12 OFF OFF ON ON OFF
13 ON OFF ON ON OFF
14 OF ON ON ON OFF
15 ON ON ON ON OFF
16 OFF OFF OFF OFF ON
17 ON OFF OFF OFF ON
18 OFF ON OFF OFF ON
19 ON ON OFF OFF ON
20 OFF OFF ON OFF ON
21 ON OFF ON OFF ON
22 OFF ON ON OFF ON
23 ON ON ON OFF ON
24 OFF OFF OFF ON ON
25 ON OFF OFF ON ON
26 OFF ON OFF ON ON
27 ON ON OFF ON ON
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Connecting non IEEE-488 chromatographic devices

Some non IEEE-488 devices produce analog output signals. A busSAT/IN 
Module converts the analog output signals to digital signals, then transmits 
them to the busLAC/E card. The busLAC/E card is connected to an I/O 
distribution box. Supported non IEEE-488 chromatography devices connect 
through a network interface card (NIC), an optional 8-port serial card, an I/O 
distribution box, or a PC COM port. 

Ethernet instruments
Ethernet instruments can connect directly to the network interface card in the 
computer. If you are connecting multiple Ethernet instruments, use a 
Waters-supplied switch to connect the Ethernet cable from the computer to 
the switch, and then plug each instrument into the switch.
Tips: 

� A single direct Ethernet connection can require crossover cables to 
control your A1100, 6850, or EMD 1000.

� Multiple Ethernet connections using a switch can require crossover 
cables to control the ZQ mass spectrometer through a network switch. 
Modifying or resetting the link speed and duplex properties of your 
network interface card (NIC) to Auto Detect can also be necessary. In 
both cases, if you are using more than one NIC, you can modify the 
settings for a second NIC using the DHCP wizard, after you install 
Empower software.

8-Port serial card instruments
The 8-port cable connects directly to the Equinox serial card. Insert the RJ45 
cable into Port 1 of the 8-port cable. Depending on the instrument you are 

28 OFF OFF ON ON ON
29 ON OFF ON ON ON

1. ON = Closed or 1. OFF = Open or 0.

Settings for the Waters 600, 410, 996, PCM, and TCM (Continued)

IEEE-488 
address

DIP switch settings1

1 2 3 4 5
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controlling, the other end of the cable connects directly to the instrument or to 
the instrument via a cable adapter. Use Waters-supplied adapters for this 
connection. 
Tip: Port 1 on the Equinox cable gives an address of 3 in Empower software.

busLAC/E I/O distribution box
The I/O distribution box connects to the busLAC/E card. Non IEEE-488 
chromatography devices communicate with the busLAC/E card through the 
I/O distribution box over serial cables. The I/O distribution box allows you to 
connect up to four non IEEE-488 devices and up to eight non IEEE-488 
detectors using busSAT/IN Modules.

Non-IEEE device connections
The following table lists non-IEEE device connections supported by Empower 
software.

Non-IEEE device connections

Device Ethernet 8-port serial 
card

busLAC/E 
card PC COM port

SAT/IN and 
busSAT/IN

No Yes; 
split-channel 
operation is not 
supported

Yes; 
split-channel 
operation is 
supported

Yes; 
split-channel 
operation is 
not supported

eSATIN Yes No No No
474 Detector No Yes No Yes
5890/7673 
GC and 
Controller

No Yes
� Requires two 

serial cables
� Dual-tower 

configuration 
is supported

No No
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6890/
6890+
GC

No Yes
� Dual-tower 

configuration 
is supported

� Requires one 
serial cable

No No

6850 Yes
(SN > 
US10243001)

Yes
(SN < 
US00003200)

No No

Headspace 
7694

Yes Yes No No

Headspace 
G1888

Yes No No No

Waters 3100 
Mass 
Detector

Yes No No No

Waters 
Single Quad 
(SQ) 
Detector

Yes No No No

Waters 
Triple Quad 
(TQ) 
Detector

Yes No No No

Non-IEEE device connections (Continued)

Device Ethernet 8-port serial 
card

busLAC/E 
card PC COM port
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Connecting mass spectrometers

You can connect an SQD, TQD, 3100, ZQ 2000, ZQ 4000, or an EMD 1000 
mass spectrometer to an Empower Personal workstation or to an acquisition 
client (a client connected directly to one or more chromatographic systems). 
Restriction: Mass spectrometers cannot be connected to a LAC/E32 module.
Rule: Examples in this section reflect the current system configuration. The 
specific type of network card that is shipped from Waters is subject to change 
at any time. 
The computer requires two network cards:

� MS network card, such as the Intel PRO/100 VM Network Connection, 
for connecting the Mass Spectrometer to the computer

� Network card, such as the Intel PRO/100+ Management Adapter, for 
connecting to your facility�s network

Requirement: If you want to switch among using an SQD, TQD, 3100, ZQ 
2000, ZQ 4000, or an EMD 1000, you must perform these actions:

� Uninstall the existing instrument driver (ID)/instrument control 
software (ICS) for the first mass detector.

� Install the ID/ICS for the second mass detector.
� Configure the new system.

If you obtain the computer (Empower Personal workstation or acquisition 
client) from Waters, the network cards are installed and configured before 
shipment to you. If you installed your own network cards, use these 
instructions as a guideline.

Connecting mass spectrometers to the Empower system
Restriction: Mass spectrometers cannot be connected to a LAC/E32 module.

To connect a mass spectrometer to the Empower system 

1. Locate the computer within 16 feet (5 m) of the instrument.

2. Ensure that the computer has two network cards:
� MS network card
� Network card for connecting to your facility�s network
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3. For a direct connection (possible with the 3100, ZQ, and EMD 
instruments when no other Ethernet detector is included in the system), 
connect one end of the network cable to the network port (no label) on 
the rear panel of the instrument.
Requirement: For the EMD instrument, use a crossover cable. For the 
ZQ instrument, use a straight-through cable.

4. Connect the other end of the network cable to the port labeled MS on the 
rear panel of the Empower workstation.
Requirement: If you are using a switch, connect it to the computer�s MS 
network card, and then connect the mass spectrometer to the switch. 
Use a Waters-supplied switch for this connection. 

5. Start up the system (see �Powering-on the system� on page 2-23). 

6. Continue with �Configuring mass spectrometers� .

Configuring mass spectrometers
In general, configuring a ZQ or EMD mass spectrometer involves these tasks:

� Create a Micromass user account
� Configure an MS network connection

� Install Microsoft® Internet Information Services (IIS)
� Set IIS properties for file transfer protocol (FTP) service and default 

FTP sites
� Test the connection

To configure IIS and FTP on Waters ZQ and EMD mass spectrometers, you 
must have a valid operating system user account with required access 
privileges.
Requirement: Because the IIS installation and configuration procedure on 
Windows XP differs from that on Windows Vista, follow the configuration 
procedure for the particular Windows operating system you are using to 
prevent a potential Windows crash.
Tips: 

� The tasks listed above are not part of the configuration procedure when 
controlling SQ-, TQ-, or 3100-based systems.
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� If you obtain the Empower workstation from Waters, the network cards 
are configured before shipment to you.

Configuring IIS on Windows XP

To add IIS on ZQ and EMD instruments on Windows XP

1. From the desktop, click Control Panel > Add/Remove Programs > 
Add/Remove Windows Components.

2. In the Windows Components Wizard, click Internet Information 
Services (IIS), and then click Details.

3. On the Internet Information Services (IIS) page, select File Transfer 
Protocol (FTP) Service, confirm that the World Wide Web Service is 
selected, and then click OK.

4. In the Windows Components Wizard, click Next.

5. When the configuration changes complete, click Finish.

6. Close the Add/Remove Programs dialog box.

To configure IIS on ZQ and EMD instruments on Windows XP

1. From the desktop, click Start > Control Panel > Administrative Tools > 
Computer Management.

2. In the left pane of the Computer Management window, expand Services 
and applications, and then expand Internet Information Services.

3. Under Internet Information Services, right-click Default FTP Site, and 
then click Properties.

4. In the IP address field on the Default FTP Properties page, type 
64.1.1.1.

5. On the Security Accounts tab, clear the �Allow Anonymous Connections� 
check box.

6. On the Home Directory tab, clear the Log Visits check box, and then 
click OK.

7. Set the local path into which you installed MassLynx or Empower 
software:
� For MassLynx:
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� In the Local Path box, type C:\, and then click OK.
� For Empower 1154:

� For a ZQ instrument, in the Local Path text box, type 
<drive_letter>:\Empower\ZQ, and then click OK.

� For an EMD 1000 instrument, type 
C:\Empower\Instruments\MassSpec.

� For Empower 2154 (EMD1000 and ZQ):
� In the Local Path box, type 

<drive_letter>:\Empower\Instruments\MassSpec.

Configuring IIS on Windows Vista

Rule: Do not configure IIS by means of Computer Management > Services and 
Applications > Internet Information Services > FTP Sites > Default FTP Site 
because Windows might crash.

To set up IIS and FTP on Windows Vista

1. Select Control Panel > Programs and Features, and then select �Turn 
Windows features on or off.�

2. On the Windows features page, select Internet Information Services, 
and turn on FTP Publishing Service, FTP Management Console, and 
FTP Server.

3. Under Web Management Tools, turn on IIS Management Console.

4. Accept the changes and reboot (if necessary).

To configure IIS and FTP on Windows Vista

1. Access Computer Management > Services and Applications > Internet 
Information Services (IIS) Manager. 
Rule: Do not access Internet Information Services IIS 6.0 Manager.

2. In the center window of IIS Manager, click the connection > FTP Sites.

3. In the right window, click the item �Click here to launch�.

4. In the Internet Information Services (IIS) 6.0 Manager window, expand 
the tree, right-click the default FTP site, and then click Properties.
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5. On the Default FTP Site Properties page, configure properties as 
required.

Exception: On Windows Vista Enterprise SP1, when installing IIS and FTP 
for the ZQ or EMD detectors, the related FTP Service does not start 
automatically when you reboot the operating system. 

To configure FTP Publishing Services to start automatically

1. On the Control Panel, click Computer Management > Services.

2. In the list of services, right-click FTP Publishing Services, and then click 
Properties. 

3. In the Start up Type box, select Automatic.
Tip: On Windows Vista Enterprise SP1, if you encounter problems 
establishing communications with a ZQ or EMD detector, add the FTP Server 
to the list of Windows Firewall exceptions, and then reboot the system to 
successfully establish communications with the ZQ or EMD detector.

Powering-on the system

Powering-on the Empower system entails powering-on the individual 
instruments and devices in a particular sequence.
This section contains the startup sequence for the Empower system and its 
peripheral equipment.
Tip: For information on starting up the Empower Enterprise client/server 
system, see the Empower 2 System Administrator�s Guide, Revision B.

To power-on instruments and devices

1. Power-on all equipment controlled through the IEEE-488 bus, waiting 
until any internal diagnostic tests finish.
Restriction: You cannot run methods or use Run Samples unless all 
devices on the IEEE-488 bus that are assigned to a system on the 
Empower system are powered-on and have successfully completed any 
calibration tests.

Caution: Ensure that the computer�s power supply is set to the correct 
voltage for your site. If it is set incorrectly, your computer can be 
damaged. 
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Requirement: Power-on the pumps of an LC system first to establish a 
flow before powering-on the detectors. Also, ensure that the carrier gas 
is flowing before powering-on GC instruments. Do not power-on (or 
power-off) instruments connected to a bus running any systems.

2. Power-on the computers.

3. Power-on all equipment controlled by the Empower system that is not 
under IEEE-488 control; that is, all equipment controlled through the 
I/O distribution box (busSAT/IN Modules, connected analog detectors, 
and GC instruments).

4. Power-on all equipment not controlled by the Empower system (for 
example, computer peripherals such as printers).
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3 Installing an Empower Personal 
workstation

This chapter explains how to install Empower 2 Feature Release 5 
software on a standalone Empower Personal workstation.
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Requirements

Complete these tasks before you begin the installation:

1. Ensure the workstation has the required hardware and software, as 
specified in the table titled �Requirements for Empower Personal or 
client computers, LAC/E modules� on page 1-6.

2. Log in to the operating system using an account with Administrator 
privileges.

3. Back up and defragment the hard drive (see the Microsoft 
documentation and Help system) to ensure smooth installation of and 
optimum performance from Empower.

4. Empower 2 FR 5 software requires a minimum page file size of 1024 MB 
on Windows XP SP2. For Windows Vista, configure the system so that 
the virtual memory setting automatically manages the paging file size.

5. Close all applications, and then restart the Personal workstation.

6. Verify that the disk drive allows enough space to install Empower 
software (see the table below).

When you start the installation, the combined free disk space of all local 
drives must equal or exceed 5 GB. If the free disk space is more than 2.5, but 
less than 5 GB, an on-screen warning message appears. If the free disk space 
is less than 2.5 GB, you will not be able to install Empower software. The 
installation will stop if you are not in an Administrator group account, you 
have an unsupported operating system (such as Windows 98), you have less 
than 256 MB of memory, or you are using Windows Vista Business or 
Windows XP but do not have the correct service pack.
Restriction: Empower 2 FR 5 Personal is not supported on Windows 2000 
Professional.

Minimum disk space requirements

Purpose Minimum free space
Empower application 250 MB

Oracle® application and 
database

2.0 GB

Empower raw data 200 MB
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Installing Empower 2 FR 5 software

You install Empower software from the Empower 2 FR 5 DVD. You can 
perform a typical installation to install the software on the C drive or default 
location, or a custom installation to specify a different drive. Allow 
approximately 30 minutes to install the software.
Exception: If you are performing an upgrade to Empower 2 FR 5, do not 
continue with this procedure. See the Empower 2 Upgrade and Configuration 
Guide, Revision B for upgrade procedures.

Starting the installation
Requirement: If you are using Mass Spectrometry with ZQ or EMD, make 
sure you have IIS and FTP installed before you install Empower. See 
�Configuring mass spectrometers� on page 2-20.

To install Empower 2 FR 5

1. Insert the Empower 2 FR 5 DVD into the DVD drive.

2. Browse to the Personal folder on the DVD and double-click 
EmpowerPersonalFR5setup.exe.
Exception: If you are using Windows Vista, you must right-click the 
EmpowerPersonalFR5setup.exe file and then select �Run as 
Administrator�.

3. On the Choose Setup Language page, select a language from the 
drop-down list.
Requirement: If Microsoft .NET Framework 3.0 software is installed on 
your system, the installation continues. However, if the software is not 
installed, the Requirement wizard page appears. On that page, click 
Install.

4. On the Welcome page, click Next. 

5. On the License Agreement page, accept the license agreement, and then 
click Next.

6. On the Customer Information page, enter your user name, organization, 
and serial number, and then click Next.

7. On the Setup Type page, leave Typical selected, and then click Next. 
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Alternative: Select Custom if you want to install the software on a drive 
other than C, then continue with the next section, �Finishing a custom 
installation�.

8. On the Ready to Install the Program page, click Install to start the 
installation.
Result: The Empower Setup wizard installs the Empower and Oracle 
program files on the hard drive. This process can take several minutes.

9. On the Install Shield Wizard complete page, click Finish. 

10. Click Yes at the next page to restart the workstation and then continue 
with �Completing the installation� on page 3-5.

Finishing a custom installation
If you selected Custom in step 7 of �Starting the installation�, complete the 
installation as follows.

To finish a custom installation

1. On the Custom Setup page, specify the program features you want to 
install. 
Tip: By default, the �Install to� location points to drive C. 
To designate drives other than drive C, click an icon (for example, 
Empower Oracle Files and Database), and then click the Change 
Feature Location button.

2. On the Change Current Destination Folder page, select the desired 
drive, and then click OK to return to the Custom Setup page. Repeat for 
all feature locations. Click Next.

3. On the Ready to Install the Program page, click Install to start the 
installation.
Result: The Empower Setup wizard installs the Empower and Oracle 
program files on the hard drive, a process that can take several minutes.

4. On the Install Shield Wizard complete page, click Finish. 

5. Click Yes at the next page to restart the computer, and then continue 
with the next section.
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Completing the installation
After the computer restarts, do the following to complete the installation.

� Log in to the operating system using an account with Administrator 
privileges. (The account must be the same one that you logged in to 
when starting the installation.)

� If your system includes a busLAC/E card, you must install and configure 
the busLAC/E driver for Empower. Follow the procedure in the next 
section.

� If you want to install software support for one or more instruments, use 
the Waters Instrument Control Options Pack (ICOP) installation DVD. 
Browse to the appropriate language folder on the DVD, locate the 
setup.exe file, and then double-click the file (for Windows Vista, 
right-click the file and then select �Run as Administrator.�) Follow the 
prompts to install the software support you need.

� Install the Empower base package key and options.
� Verify the installed files.

Installing and configuring a busLAC/E driver

After you install Empower 2 FR 5, install and configure the busLAC/E driver. 
The procedure differs slightly between Windows XP and Windows Vista.
Tip: If the Found New Hardware Wizard dialog appears automatically, start 
with step 5. If not, follow the procedures to access the Wizard manually.

To install and configure the busLAC/E driver on Windows XP

1. Right-click My Computer, and then select Manage. 

2. On the Computer Management page, click Computer Management 
(Local) > System Tools > Device Manager. In the right-hand pane, locate 
Other devices > PCI Device. 

3. Right-click PCI Device, and then select Properties. 

4. In the General tab on the PCI Device Properties page, click the Reinstall 
Driver button. The Found New Hardware Wizard page appears. 

5. On the Found New Hardware Wizard page, select �Yes, this time only� 
and then click Next. 
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6. Select �Install from a list or specific location (Advanced)� and then click 
Next. 

7. Select �Search for the best driver in these locations� and select the 
checkbox �Include this location in the search.�  

8. Click the Browse button and include the following directory in the 
search: C:\Empower\BuslaceDrivers.

9. Click Next.
Result: The BusLAC/E Driver installs. It appears as �Buslace PCI 
KMDF Device Driver� under BusLAC/E Drivers in Device Manager.

To install and configure the busLAC/E driver on Windows Vista

1. Right-click Computer, and then select Manage.

2. On the Computer Management page, click Computer Management 
(Local) > System Tools > Device Manager. In the right-hand pane, locate 
Other devices> PCI Device. 

3. Right-click PCI Device, and then select Properties.

4. In the General tab on the PCI Device Properties page, click the Reinstall 
Driver button. The Found New Hardware - PCI Device page appears.

5. On the Found New Hardware - PCI Device page, select "Browse my 
computer for driver software (advanced)." 

6. Under �Browse for driver software on your computer�, click the Browse 
button and select the directory C:\Empower\BuslaceDrivers. 

7. Select the checkbox �Include subfolders� and then click Next. 

8. When the Windows Security message �Would you like to install this 
device software?� appears, click Install.
Result: The BusLAC/E Driver installs. It appears as �Buslace PCI 
KMDF Device Driver� under BusLAC/E Drivers in Device Manager.
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Installing Empower Personal Base Package Key and 
options

About licenses and options
With Empower 2 Feature Release 5, Waters introduces a new Software 
License Management System for managing Waters software licenses and 
options. You must install the Empower base license to access Empower and 
install other licenses and options. 
Empower 2 FR 5 Personal workstations on Windows XP can use the new 
License Management System or the license floppy key disks, but you cannot 
use both.
Restriction: You cannot use both procedures to install Empower licenses and 
options. If you install licenses/options using the key disks, you cannot use the 
Waters Licensing Wizard to install additional licenses/options. If you already 
used key disks and you want to use the Waters Licensing Wizard, you must 
remove the licenses/options you installed using the key disks. Then you must 
use the Wizard to activate all your licenses and options. Once you do so, you 
must also the Wizard to deactivate them.
To view active licenses and options, use the Show Licenses option in the 
Waters Licensing Wizard. This option is available whether you use the key 
disks or the Wizard to activate your licenses and options.
Serial numbers purchased from Waters to use with the Waters Licensing 
Wizard or the key disks are required for activating or deactivating the 
Empower licenses and options. If you need to transfer a license or option from 
one Empower Personal workstation to another, you must deactivate it from 
the original Personal workstation before you activate it in a new Personal 
workstation. 
Activate licenses and options in the following order:

� Base license (includes 5 named user licenses)
� Named User Licenses (if you purchased additional licenses)
� System Control Licenses
� Options
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The number of allowed named users is based on the number of Named User 
Licenses you installed. You can create a number of active accounts equal to 
the number of Named User Licenses you purchased. 
The number of allowed online systems (up to a maximum of 4) is based on the 
number of System Licenses you activated.

Requirement: If you are using key disks, the computer must write to the key 
disk as you manage licenses. Do not write-protect the key disk.
For project-configurable options, when you activate an option following the 
procedures in this section, project-specific options are enabled for all projects. 
You can disable the option for specific projects (see �Modifying project 
properties� in the Empower Help).
Exception: You cannot activate an option intended for an Enterprise or 
Workgroup system on an Empower Personal workstation, nor can you activate 
an option intended for an Empower Personal workstation on an Enterprise or 
Workgroup system.
Tip: In some cases, during installation you will see a pop-up message 
indicating that the Waters Licensing Wizard has detected one or more licenses 
that still remain on your system. This may happen even after all key disks 
have been manually uninstalled. If you have not manually uninstalled all key 
disks, click No, and continue to manually uninstall all key disks. If you have 
manually uninstalled all available key disks, click Yes to remove any 
remaining licenses/options and open the Licensing Wizard.

Installing the Base Package Key and options using the Waters 
Licensing Wizard

To install the Empower Personal Base Package Key and options

1. Log in to the Personal workstation (where you installed Empower 2 FR 
5) as an administrator user.

2. From the Start menu, click Start > Programs > Empower > Waters 
Licensing Wizard.

3. On the Waters Licensing Wizard log on page, enter the default user 
name and password, leaving Local as the default database. Click Log 
On.

Caution: Do not uninstall Empower software until after you uninstall 
the licenses and options, or they become unusable.
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Tip: Empower comes with a default System user account which can be 
disabled but not removed from Empower. The default user name for this 
account is System, and the default password is Manager. When logging 
in to Empower software and using the licensing wizard for the first time, 
enter the default user name and password. Subsequently, any user with 
the Administrator privilege can access the Waters Licensing Wizard.

4. On the task page, click �Request software registration�.

5. On the �Request software registration � Create registration file� page, 
enter a valid name and location for your software registration file, and 
then click Next. 
Tip: This file stores your software registration information.

6. When the �Request software registration � Registration file created� 
page appears, click the address link. 
Tip: If your computer has Internet access, it connects to the Waters 
License Activation Center Web site where you complete the request 
process and receive your license activation file.
If your computer does not have Internet access, move the software 
registration file that you just created to a computer with Internet access 
so you can relay your request to Waters. Connect to the Waters License 
Activation Center web site. Follow the instructions to activate your 
license(s). After you receive the license activation file from the web site, 
move the file back to this computer so that you can activate your 
licenses.

7. Once you have your license activation file, go to the Waters Licensing 
Wizard task page and select Activate Licenses.

8. Select the license activation file you downloaded from the Waters 
License Activation Center web site, and then click Next.
Requirement: You must complete the activation process using the 
computer on which you created the software registration file.

9. On the License Activation Complete page, you will see a list of licenses 
and options that have been successfully activated. Click Finish.
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Installing the Base Package Key using key disks
Record the serial number of the Base Package Key before installing the key 
disk. You will be prompted to specify it during installation. 
Restrictions: 

� DO NOT remove the disk from the drive to view the serial number after 
the installation starts. If you did not record the number, leave its field 
blank and click OK.

� You cannot use Empower key disks on Windows Vista systems.

To install the Empower Personal Base Package Key 

1. Log in to the Personal workstation (where you installed Empower 
software) as an administrator, and insert the 3.5-inch Empower 
Personal workstation key disk into the disk drive. 
Requirement: Verify that the disk is not write-protected.

2. Click Start > Run. In the Run dialog box, type A:\Setup.exe, and then 
click OK. 

3. On the Empower Option Setup page, click OK to install the Empower 
Personal Base Package Key. 
Tip: Allow several minutes for the Empower Option Setup page to 
appear while the Empower key disk is read onto your hard disk.

4. On the Enter Serial Number page, enter your serial number. 
Tip: This information appears in the verification file. If no number is 
entered, a blank line appears in the Verify Files output.
Restriction: DO NOT remove the disk from the drive to view the serial 
number. If you did not record the number, leave its field blank and click 
OK.

5. When the installation is complete, click OK to close the Empower 
Options message box. 
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Installing Empower options using key disks
Record the serial number of the option before installing the key disk. You are 
prompted to specify it during installation. 
Restriction: DO NOT remove the disk from the drive to view the serial 
number after the installation starts. If you did not record the number, leave 
its field blank and click OK.

To install the Empower options

1. Log in to the Personal workstation as an administrator user and insert 
the Empower Option key disk into the disk drive.

2. Click Start > Run. In the Run dialog box, type disk drive:\Setup.exe, 
and then click OK. 
Result: After a few minutes, the Empower Option Setup page appears. 

3. Ensure that the name of the option being installed is correct, and then 
click OK.

4. Perform one of the following actions:
� If the option was not previously installed, an Empower Option 

message box appears after successful installation. Click OK to close 
the message box.

� If the option is already installed on your Empower Personal 
workstation, an Empower Option message box appears. Click 
Cancel to close the message box.

� If the option is already installed on a different Empower Personal 
workstation, a Setup message box appears. Click OK to close the 
message box. To remove the option from an Empower Personal 
workstation, continue with �Uninstalling Empower licenses and 
options� on page 3-12. 

5. On the Enter Serial Number page, enter your serial number, and repeat 
step 2 through step 4 for each option.
Restriction:  DO NOT remove the disk from the drive to view the serial 
number. If no number is entered, a blank line appears in the Verify Files 
output. 
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Uninstalling Empower licenses and options
If a license or option is currently installed on a different Personal workstation 
and you want to transfer it to this Personal workstation, you must first 
uninstall the license or option from its current workstation using the Waters 
Licensing Wizard or the appropriate key disk.

Uninstalling licenses or options using the licensing wizard

Restriction: If you installed licenses or options using a key disk, you cannot 
uninstall them using the licensing wizard.

To uninstall a license or option using the licensing wizard

1. Log in to the Personal workstation (where you installed Empower 
software) as an administrator user.

2. From the Start menu, click Start > Programs > Empower > Waters 
Licensing Wizard.

3. On the Waters Licensing Wizard log on page, enter a user name (one 
that has Administrator privilege) and a password, leaving Local as the 
default database. Click Log On.

4. On the task page, click Deactivate Licenses.

5. On the �Deactivate Licenses � Select Licenses� page, check the option(s) 
you want to deactivate, and then click Next.

6. On the �Deactivate Licenses � Create deactivation file� page, enter a 
valid name and location for your license deactivation file. This file stores 
your license deactivation information. Click Next.

7. When the �Deactivate Licenses � Deactivation file created� page 
appears, note the file location, and then click the address link. 
Tip: If your computer has Internet access, it connects to the Waters 
License Activation Center web site where you complete the deactivation 
process.
If your computer does not have Internet access, move the license 
deactivation file that you just created to a computer with Internet access 
so that you can relay your request to Waters. 

8. On the Waters License Activation Center web site, select Deactivate 
Licenses and follow the instructions to deactivate your option(s).
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Requirement: Load the license deactivation file created in step 7. 
When the process is complete, a confirmation page appears that lists all 
deactivated licenses and options.

Uninstalling licenses or options using key disks

Restrictions: 
� Verify that the disk is not write-protected. 
� If you installed licenses or options using the licensing wizard, you cannot 

uninstall them using a key disk.

To uninstall a license or option using key disks

1. Log in to the Personal workstation as an administrator user, insert the 
appropriate Empower Option key disk into the disk drive of the Personal 
workstation on which the option is installed, and click Start > Run. 

2. In the Run dialog box, type <disk drive>:\Setup.exe, and then click OK. 

3. On the Empower Option Setup page, click OK. 

4. On the Option Already Installed message box, click OK. 

5. On the Setup message box, click OK to close the message box, and then 
remove the key disk. 

Restoring sample (default) projects
If you install a new option, you can use the option sample (default) project files 
as examples for that option. You can restore the sample project files from the 
default projects DVD that came with Empower 2 FR 5 (see �Restoring 
projects� in the Empower Help).

Verifying installed files

The Empower Setup wizard creates an Empower program folder in the Start 
menu. The Empower program folder contains these items:

� Empower Installation Log � Contains information about the current 
installation.

� Empower � Starts the Empower software and displays the Empower 
Login page. After you log in, you can select one of several Empower 
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applications. For details, see �Starting and exiting from Empower� in 
the Empower Help.

� Waters Licensing Wizard � Starts the Waters Licensing Wizard, which 
you can use to request software registration, activate and deactivate 
licenses and options, or view Waters licenses and their serial numbers.

� Register Empower Node Printers � Registers printers so that you can 
print Empower reports.

� Verify Files � Verifies the integrity of the Empower software files on 
your hard disk.

Viewing the installation log
The installation log contains information about your Empower installations. 
You can read the log file to review your installation choices. In case of a partial 
or unsuccessful installation, you can review the installation log to check for 
errors.

To view the installation log

1. Click Start > Programs > Empower > Installation Log. 
Result: The program displays the Empower.log file in Notepad.

2. Review the contents of the Installation Log file.

3. Click File > Exit.

Using the file verification utility
The file verification utility checks the integrity of the installed Empower 
program, data files, and database files. 
After the installation, run the file verification utility to verify the Empower 
program and data files only (not the database files):

� As part of your installation qualification, if you purchased the Empower 
Qualification option

� To ensure that the Empower files did not change since installation

To run the file verification utility

1. Click Start > Programs > Empower > Verify Files. 
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Result: The file verification utility compares the installed Empower files 
checksum with a previously stored checksum and then creates a file 
verification results log.

2. Review the contents of the file. Print or save a copy of the results.

3. Click File > Exit.

Checking for Empower service packs

Waters periodically releases service packs to address existing issues or to 
provide enhanced functionality. They are available for downloading from the 
Waters Elite Web site and should be installed according to the instructions 
contained in their associated release notes. If you want physical media, note 
the part number from the web site and contact your local Waters subsidiary to 
place an order. 
Tip: If you are using real-time virus scanning, exclude all Empower-related 
folders and their sub-directories. Some real-time virus scanners mistake 
normal Empower functionality for virus activity and can therefore interfere 
with data buffering.
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4 Installing an Empower 
Enterprise server or primary 
workgroup on a Windows server

This chapter explains how to perform a standard installation of the 
Oracle® software and the Empower 2 Feature Release 5 software on a 
Windows server in an Empower Enterprise system or on a primary 
Empower workgroup computer. 
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Server planning

The database server runs two applications: 
� WatersService � Responsible for writing raw data files from Empower 

nodes, copying raw data from project to project (through the Empower 
application), and creating new projects. 

� Oracle Database � Stores methods, audit trails, and specific raw data 
file parameters (the data points are stored as external files controlled by 
WatersService).

The Empower server installation program reads the amount of physical 
memory that your system contains, then automatically configures the Oracle 
initialization parameters based on available resources.
The installation program assumes that the server is used exclusively as the 
Empower database server. Other applications running on the server can 
necessitate your adjusting the initialization parameters accordingly. 

Network considerations
A domain-based network infrastructure is required for the Empower 
Enterprise/Workgroup system. In addition, all Empower-related computers 
(clients, LAC/E32 modules, and servers) must be synchronized to a time server. 
In domains based on Windows 2000 Server and Windows Server 2003, the 
domain controllers are automatically configured to act as time servers to the 
domain.
To maximize service time and minimize issues related to the network 
environment, Waters recommends you follow these guidelines:

� All Empower-related accounts, computers and users, must reside within 
the same domain.

� If you are using real-time virus scanning, exclude all Empower-related 
folders and their sub-directories. Some real-time virus scanners mistake 
normal Empower operations for virus activity and can therefore 
interfere with data buffering.

Group policy objects

System administrators use Group Policy Objects (GPOs) to define and enforce 
settings in an Active Directory network. Administrators can apply settings to 
4-2 Installing an Empower Enterprise server or primary workgroup on a Windows server



users and computers based on locally defined group and site membership 
criteria. Before defining GPOs in an Empower network, keep in mind that 
Empower software is a distributed chromatography data acquisition system 
that relies on remote access and the DCOM configuration to carry out its 
activities. Empower software makes use of information stored in the database 
and in individual flat files, such as instsrv.dat (instrument configuration 
information) and channel_id.dat (actual raw data file).
If GPOs are used in an Empower network, Waters recommends that you 
follow these guidelines:

� Place Empower nodes in their own Organization Unit (OU). Define 
GPOs for the OU that minimize allowable changes: for example, test 
Microsoft hot fixes and service packs before applying them to the 
environment.

� Grant administrators full access to the registry and file system so that 
they can properly install software.

� Limit changes to the file system protections expected by the Empower 
application.

GPOs can interfere with successful Empower operation. For example, data 
buffering can occur if the anonymous access to the raw data share is altered, 
or the editors for the COM instruments can sometimes operate improperly if 
the access control list for the HTML directories is altered.

Memory considerations
The server in an Enterprise system or Workgroup requires sufficient memory 
for Oracle 10.2.0.3 and Empower software to operate. The amount of required 
memory depends on the number of applications, users, and the operating 
system. The largest quantity of memory is used by Oracle. When Oracle 
initializes, it creates a space in memory for most of the Oracle functions. The 
space is called the SGA (for more information about the SGA, see the Oracle 
documentation or your database administrator). The server must have 
adequate memory, and the memory must be configured correctly. The amount 
of required memory depends on the number of client and LAC/E32 modules, 
users, chromatograms per project, and the number of integrated peaks per 
channel. 
The server�s virtual memory must be set to at least four times the amount of 
installed physical memory (see �Changing the page file size� on page 6-2).
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Disk space considerations
Each Workgroup or Enterprise system requires sufficient disk space for 
Oracle 10.2.0.3 and Empower software (see the following table).

You must install the various software components on multiple drives to 
maximize performance and also the ability to recover from disk failures. The 
previous table contains the minimum requirements at installation. However, 
you must also account for additional disk space when the system is 
operational. 
You must consider the following items when sizing drives for future use:

� Empower program files
� Empower raw data files
� Empower database

Empower program files

� Empower and Oracle application files � Fixed size at installation, 
approximately 1.6 GB.

� Archive log files � 200 MB each; allow space for at least 50 logs (10 GB 
total disk space). The number of archive logs you generate will depend 
on the level of database activity. The number of archive logs maintained 
on the server depends on how often the database is backed up as well as 

Minimum disk space requirements

Purpose Minimum Free Space Drive
Empower application 500 MB Program-drive
Oracle application 1.3 GB Program-drive
Empower raw data 1.0 GB RawData-drive
Oracle database 2.0 GB1

1. This assumes you use the Waters DVD to install Oracle.

Database-drive

Archive Log Dest1 10 GB2

2. Each archive log file is 200 MB. The 10.0 GB minimum allows for 50 archive logs.

RawData-drive

Archive Log Dest2 10 GB Program-drive
Mirrored Redo and 
Control files

1 GB RawData-drive
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overall activity. If you perform daily backups, the archive logs files are 
deleted after they are backed up.
Tip: Each of the two locations for archive logs contains a full set of logs. 
Archive logs are essential for recovering databases. If you fill the space 
for archive logs, the database �hangs� until you provide more space for 
the logs.

Empower raw data files

The size of the Empower chromatography raw data files is variable, based 
approximately on (sample rate) times (run time) times (number of samples). 
PDA and MS files are bigger because wavelength and mass range must be 
included. The total space requirement is based on how often you archive and 
how many systems are creating raw data files.
Tip: Raw data files can grow very quickly. Hundreds of GB may be needed. If 
you use up too much space, you can archive older projects to regain space on 
the raw data drive.

Empower database

The database datafiles are configured to autoextend. As projects, raw data 
files, and results are created, the initial database datafile must autoextend to 
store all information. 
Tip: The amount of free disk space will limit the extension of the database 
files. You might need to add additional tablespace files to other disks with 
more space, or free up space on the original disk to allow for adequate 
extension.
Most information stored in the database consists of results. The actual 
tablespace used for each result is based on the number of integrated peaks 
(named or unknowns). Additional space is required when the System 
Suitability or Pattern Match option is enabled, or the data is from a 3D 
detector, and additional processing is requested (for example, a PDA channel 
with multi-pass purity enabled). 

Installing Empower 2 FR 5 software

Exception: If you are performing an upgrade, do not continue with this 
procedure. See the Empower 2 Upgrade and Configuration Guide, Revision B 
for upgrade procedures.
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Waters supplies Oracle software and Empower 2 FR5 software on a DVD. 
Procedures in this chapter assume that you want to install Oracle 
automatically using default settings. Allow approximately 45 minutes to 
install the software. 
By default, the Empower installer installs both Oracle 10.2.0.3 and Empower 
2 FR 5. If your site has its own Oracle license and prefers to install Oracle 
10.2.0.3 as a separate application, consider these installation issues:

� Install Oracle 10.2.0.3 software only (that is, without a database) before 
installing Empower 2. Ensure that the name of the Oracle Home 
contains the number 10.

� The HKEY_LOCAL_MACHINE\Software\Oracle\NLS_Lang registry 
key value must be changed to AMERICAN_AMERICA.WE8ISO8859P1.

� During installation, you are asked whether you want to use your 
installed Oracle software. Select Yes and supply the location of the 
Oracle program files.

Starting the installation

To start the Empower 2 FR 5 installation 

1. Insert the Empower 2 FR 5 DVD into the DVD drive.

2. Browse to the Server folder on the Empower 2 FR 5 DVD and 
double-click EmpowerServerFR5setup.exe.

3. On the Choose Setup Language page, select a language from the 
drop-down list.
Requirement: If Microsoft .NET Framework 3.0 software is installed on 
your system, the installation continues. However, if the software is not 
installed, the Requirement wizard page appears. On that page, click 
Install.

4. On the Welcome page, click Next. 

5. On the License Agreement page, accept the terms in the license 
agreement, and then click Next.

6. On the Customer Information page, enter your user name, organization, 
and serial number, and then click Next.

7. On the Custom Setup page, specify where you want the program 
features installed. 
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Tip: By default, all locations point to drive C. 
Requirement: Do not install all the features on drive C.
Recommendation: For best performance and fault tolerance reasons, 
spread the components across multiple drives. Click the Change Feature 
Location button to change the drive letter from C to different letters. On 
the Change Current Destination Folder page, select the desired drive, 
and then click OK. When you return to the Custom Setup page, click 
Next.

8. On the Empower Database page, select �Install Oracle and create a new 
Empower database�, and then click Next. (If you do not want to create a 
database, select �Install Oracle without creating an Empower 
database.�)

9. On the Database Options page, specify the locations of the archive and 
mirror directories by changing the drive letter of the provided paths, and 
then click Next.
Tip: Typically, the mirror directory (containing mirrored control files 
and redo logs) and the first archive directory are installed to the raw 
data drive. The second archive directory is installed to the program file 
drive.
Recommendation: Waters recommends you change only the drive letter 
of these database options, and keep the default path. Be sure to record 
this information with your system configuration records.

10. On the Oracle Database Domain Name and SID page, enter the Oracle 
Service Identifier (SID) and the Oracle Database Domain Name, and 
then click Next. 
Tip: The database domain name typically consists of <computer 
name>.domain (for example, EMPSRVR1.WATERS.COM, where the 
computer name is EMPSRVR1, and the domain is WATERS.COM). 
Requirement: The database SID can be any combination of 
alphanumeric characters, up to 8 characters. However, it must start 

Caution: If you are installing a server with less than 4 physical drives 
(such as a workgroup Primary PC), the path to the EmpowerMirrorDB 
directory should be to a drive other than the physical drive selected for 
the Empower Oracle Database. If the location of the mirrored files is 
on the same physical drive as the database, database recovery in the 
event of a disk malfunction may be impossible.
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with WAT to automatically populate the Empower 2 database field in 
the login window.

11. On the �Ready to Install Empower Server - Feature Release 5� page, 
click Install to start the installation.

12. On the InstallShield Wizard Completed page, click Finish.

Configuring a database net service name
Use the following procedure to create a net service name, or modify the 
existing net service name.

To configure a net service name

1. Click Start > Programs > Oracle � Empower102 > Configuration and 
Migration Tools > Net Configuration Assistant.

2. On the Welcome page, select Local Net Service Name configuration, and 
then click Next. 

3. On the Net Service Name Configuration page, ensure that Add is 
selected, and then click Next.

4. On the Service Name page, enter the global database name, and then 
click Next. 
Tip: The global database name is the combination of the Oracle Service 
Identifier (SID) and the database domain name, as supplied during 
installation.
Example: If the SID is WAT7, and the database domain name is 
Empower1.Waters.com, the global database name is 
WAT7.Empower1.Waters.com.

5. On the Select Protocols page, ensure that TCP/IP is selected, and then 
click Next.

6. On the TCP/IP Protocol page, enter either the host name or the IP 
address of the server in the Host Name field. Leave the default port 
selection at 1521, and then click Next.

To test the connection

1. On the test page, select �Yes, perform a test�, and then click Next. 
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Result: The test will fail, indicating the �ORA-01017 � invalid 
username/password� error. If the failure is associated with any error 
other than ORA-01017, contact Waters Technical Support.

2. Click Change Login. On the Change Login page, enter System in the 
Username field and Empower in the Password field. �Empower� is the 
default password for the Oracle System account in Empower 2. 

3. Click OK.

To specify the net service name

1. On the Net Service Name page, enter a name in the Net Service Name 
field, and then click Next. 
Requirement: The name that you enter appears in the Database field of 
the Empower Login page. When using a client with a LAC/E32module, 
the client and the module must use the identical net service name.

2. On the �Another Net Service Name?� page, Select No, click Next until 
the Welcome page of the Oracle Net Configuration Assistant wizard 
appears, and then click Finish. 

Configuring a shared tnsnames.ora file
Use the Empower 2 FR 5 client/LACE32 installer to create an environmental 
variable named TNS_ADMIN. The value for this variable is the path to the 
location of a shared folder containing a pre-configured tnsnames.ora file. 
Using this variable on client and LAC/E32 modules removes the need to 
manually configure and maintain individual tnsnames.ora files. If you use 
this feature, be sure to place the tnsnames.ora file in a share on a server that 
is accessible so that your users can log in to Empower 2 FR 5.
Tip: Locate the shared tnsnames.ora file in the \Empower\Projects directory. 
It is shared with the appropriate security settings applied and must be 
available for normal Empower 2 FR 5 functionality.

Configuring Windows Server 2003 for a shared tnsnames.ora file

To use the TNS_ADMIN environment variable with Empower database 
servers running Windows Server 2003, you must modify the default Local 
Security Policy.
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To configure Windows Server 2003 local security settings

1. Log on to the Empower database server as an administrator.

2. Access Administrative Tools > Local Security Policy.

3. In the tree, click Security Settings.

4. Double-click on the policy �Network Access: Allow Everyone permissions 
to apply to Anonymous,� and then select Enabled.

5. Click Apply, and then click OK.

6. Exit the Local Security Policy.

To configure a shared tnsnames.ora file

1. On the Empower database server, browse to the <Oracle programs 
drive>:\Empower\Oracle\Oracle102\Network\Admin directory.

2. Locate the tnsnames.ora file, right-click the file, and then click Copy.
Requirement: If you have multiple Empower Database servers, add 
them to the tnsnames.ora file using the Net Configuration Assistant (see 
�Configuring a database net service name� on page 4-8) before copying 
the tnsnames.ora file.

3. Browse to the <raw data drive>:\Empower\Projects directory, and 
paste the tnsnames.ora file into the folder.
Recommendation: Put the share in the same directory that will hold 
Empower raw data. If you use a custom directory, set the share 
permissions as described in the next section.

Configuring the Empower Projects directory
Requirement: To ensure the proper level of access and security, set the share 
file access to Read-Only Access for Everyone and Full Access for System. You 
must configure the access settings in the Security tab on the Share Properties 
page.
Configuring the Projects directory entails these tasks:

� Configuring the Empower Projects directory on the Windows 2000 
Server or Windows 2000 Advanced Server

� Adding SYSTEM as a user when it is not already present
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� Adding the security settings to all subdirectories of the Projects 
directory

� Configuring the Empower Projects directory on a Windows Server 2003
� Adding �Everyone� to the user account permissions list
� Removing an extra user account from the permissions list
� Applying security settings to all Projects subdirectories

To configure the Empower Projects directory on the Windows 2000 server or 
Windows 2000 advanced server

1. In Windows Explorer, select the \Empower\Projects folder from the 
data drive, right-click, and then select Sharing.

2. On the Sharing tab of the Projects Properties page, click Share this 
folder, enter Waters_Projects$ in the Share name text box, and then 
click Apply.

3. Click the Security tab.

4. Clear �Allow inheritable permissions from parent to propagate to this 
object�, and then click Apply.

5. At the Security message box, click Copy.

6. In the Name box, select Everyone and clear all permissions except Read 
& Execute, List Folder Contents, and Read.

7. In the Name box, select System and enable all permissions. 

To add SYSTEM as a user when it is not already present

1. On the Security tab, click Add.

2. Scroll down the Name box and select SYSTEM.
Tip: If the Empower server is not the domain controller, then select the 
local machine name from the �Look in� list.

3. Click Add, and then click OK.

4. On the Security tab of the Projects Properties page, select SYSTEM from 
the Name box, and enable all permissions.

To apply the security settings to all subdirectories of the Projects directory

1. On the Security tab of the Projects Properties page, click Advanced.
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2. On the Access Control Settings for Projects page, click the Permissions 
tab, and then select �Reset permissions on all child objects and enable 
propagation of inheritable permissions.� 

3. Ensure that �Allow inheritable permissions from parent to propagate to 
this object� is clear, and then click Apply.

4. On the Security message box, click Yes. 
Result: The permissions are applied to all subdirectories of the Project 
directory.

5. Click OK to save the changes and close the Access Control Settings for 
Projects page.

6. Click OK to exit the Project Properties page.

To configure the Empower Projects directory on a Windows Server 2003

1. In Windows Explorer, select the \Empower\Projects folder from the 
data drive, right-click, and then select Sharing.

2. On the Sharing tab of the Projects Properties page, click �Share this 
folder�, enter Waters_Projects$ in the Share name text box, and then 
click Apply.

3. Click the Security tab, and then click Advanced.

4. On the Advanced Security Settings for Projects page, click the 
Permissions tab, and then clear �Allow inheritable permissions from the 
parent to propagate to this object and all child objects. Include these 
with entries explicitly defined here�, and then click Apply.

5. On the Security message page, click Copy.

6. In the Permission entries table, add Everyone, and remove all the other 
user accounts except the SYSTEM account.

To add Everyone to the user account permissions list

1. Click Add.

2. On the Select User, Computer, or Group page, type Everyone in the 
�Enter the object name to select� box, and verify that the appropriate 
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domain is listed in the �From this location� field. Otherwise, click 
Locations, select the domain from the list, and then click OK.
Requirement: You must have domain administrator privileges to 
perform this action.

3. In the Permission entries table, select Everyone, and then click Edit.

4. On the Permission Entry for Projects page, select Traverse Folder / 
Execute File, List Folder / Read Data, Read Attributes, Read Extended 
Attributes, Read Permissions. Verify that all other permissions are 
cleared, and then click OK.

To remove extra user account from the permissions list

1. Click on the permission entry (for example, Name = 
CREATOR/OWNER) to highlight the row.

2. Click Remove.

3. Repeat step 1 and step 2 for all permission entries except SYSTEM.

To apply the security settings to all Projects subdirectories

1. On the Advanced Security Settings for Projects page, Permissions tab, 
select �Replace permission entries on all child objects with entries shown 
here that apply to child objects.�

2. Ensure that �Allow inheritable permissions from the parent to 
propagate to this object and all child objects. Include these with entries 
explicitly defined here,� is cleared, and then click Apply.

3. On the Security message box, click Yes. 
Result: The permissions are applied to all subdirectories of the Project 
directory.

4. Click OK to save the changes and exit the Advanced Security Settings 
for Projects page.

5. Click OK to exit the Project Properties page.

Additional configuration information

For further details specific to installing Empower 2 FR 5 in a Windows 2003 
Server SP1and R2 environment, see the document titled �Waters 
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Configuration Notes for Empower 2 Enterprise Server on Windows 2003 
Server SP1 and R2�, available from your local Waters subsidiary.

Installing Empower licenses and options

You must install the Empower base license to access Empower and install 
other licenses and options. You can install these licenses and options by using 
the Waters Licensing Wizard or by using key disks. 
Tips: 

� If you are using key disks, ensure they are stored in an accessible but 
secure location.

� Record your license numbers and store them in a secure location.
Restrictions: 

� You cannot use the Waters Licensing Wizard on computers with a 
Windows 2000 Server operating system.

� You cannot use both procedures to install Empower licenses and options. 
If you install licenses/options using the key disks, you cannot use the 
Waters Licensing Wizard to install additional licenses/options. If you 
have already used key disks and you want to use the Licensing Wizard, 
you must remove the licenses/options you installed using the key disks 
and then use the Wizard to activate all your licenses and options. Once 
you use the Licensing Wizard to activate your licenses and options, you 
can no longer use the key disk procedure.

To view active licenses and options, use the Show Licenses option in the 
Waters Licensing wizard. This is available whether you use either the key 
disks or the Wizard to activate your licenses and options.
Serial numbers purchased from Waters to use with the Waters Licensing 
Wizard or the key disks are required for activating or deactivating the 
Empower licenses and options. If you need to transfer a license or option from 
one Empower server to another, you must deactivate it from the original 
Enterprise system before you activate it in a new Enterprise system.
Requirement: If you are using key disks, the computer must write to each key 
disk as you manage licenses. Do not write-protect the key disks.
Install licenses and options in the following order:

� Base license
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� Named User Licenses
� Concurrent Users (Workgroup only)
� System Control Licenses
� Options

The number of allowed named users in the database is based on the number of 
Named User Licenses you installed. The number of active accounts cannot 
exceed the number of Named User Licenses you purchased. You install the 
licenses, install all options, and then set up your named accounts (as many as 
the total of Named User Licenses). 
The number of allowed online systems in the database is based on the number 
of System Licenses you have activated.

Exception: You cannot activate an option intended for an Enterprise or 
Workgroup system on an Empower Personal workstation, nor can you activate 
an option intended for an Empower Personal workstation on an Enterprise or 
Workgroup system.
For project configurable options, once you install an option using the 
procedures in this section, the option is enabled for all projects. You can 
disable the option for specific projects (see �Modifying project properties� in 
the Empower Help).

Installing Empower licenses or options using the Licensing 
Wizard

To install Empower licenses or options

1. Log in to the server or client as an administrator user.

2. From the Start menu, click Start > Programs > Empower > Waters 
Licensing Wizard.

3. On the Waters Licensing Wizard log on page, enter the default user 
name and password, select the database to use, and then click Log On.
Tip: Empower software�s default System user account can be disabled 
but not removed. The default user name for this account is System, and 
the default password is Manager. If you are logging in to Empower 
software and using the licensing wizard for the first time, enter the 

Caution: Do not uninstall Empower until after you uninstall all 
licenses and options, or they become unusable.
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default user name and password. Subsequently, any user with the 
Administrator privilege can access the Waters Licensing Wizard.

4. On the task page, click �Request software registration�.

5. On the �Request software registration � Create registration file� page, 
enter a valid name and location for your license registration file. This 
file will store your license registration information. Click Next.

6. When the �Request software registration � Registration file created� 
page appears, click the address link. 
Result: If your computer has Internet access, it connects to the Waters 
License Activation Center web site where you complete the request 
process and receive your license activation file.
Alternative: If your computer does not have Internet access, move the 
software registration file that you just created to a computer with 
Internet access so you can relay your request to Waters. Connect to the 
Waters License Activation Center web site. Follow the instructions to 
activate your license(s). After you receive the license activation file from 
the web site, move the file back to this computer so you can activate your 
licenses.

7. Once you have your license activation file, go to the Waters Licensing 
Wizard task page and select Activate Licenses.

8. Select the license activation file you downloaded from the Waters 
License Registration web site, and then click Next.
Requirement: You must complete the activation process on the same 
server on which you created the software registration file, or on a client 
that accesses the same server.

9. On the License Activation Complete page, you will see a list of licenses 
and options that have been successfully activated. Click Finish.

Installing Empower licenses or options using key disks
Record the serial numbers of your options before installing them. You are 
prompted to specify this information during installation.
Requirement: To install an Empower option or license, Empower software 
must already be installed, and you must be able to connect to the database. 
Recommendation: To ensure successful installation, do not run Empower 
software during the installation. 
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To install an Empower license or option

1. Log in to the server or client as an administrator user and insert the 
Empower license or option disk into the disk drive.

2. Click Start > Run, in the Run dialog box, type A:\Setup.exe, and then 
click OK. 

3. On the Empower Option Setup page, ensure that the name of the option 
being installed is correct, and then click OK. 
Tip: Allow several minutes for the Empower Option Setup page to 
appear.

4. Perform one of these actions:
� If an Empower Option message box appears after successful 

installation because the option was not previously installed, click 
OK to close the message box.

� If an Empower Option message box appears because the option is 
already installed on your Enterprise system, click Cancel to close 
the message box.

� If a Setup message box appears because the option is already 
installed on a different Empower Enterprise System, click OK to 
close the message box. To remove the option from an Empower 
Enterprise System, use the procedure outlined in �Uninstalling 
Empower licenses and options� on page 3-12. 

5. On the Enter Serial Number page, enter your serial number. (If no 
number is entered, a blank line appears in the Verify Files output.)
Restriction: DO NOT remove the disk from the drive to view the 
number. Leave the serial number blank and click OK.

6. Repeat step 1 through step 5 for each option.
Tip: The Verify Files utility displays the currently installed licenses and 
options. To run Verify Files, click Start > Programs > Empower > Verify 
Files. 

Uninstalling Empower licenses or options
If a license or option is currently installed on a different Empower Enterprise 
Server or Workgroup and you want to transfer it to this Empower Enterprise 
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Server or Workgroup, you must first uninstall the license or option from its 
current location using the Waters Licensing Wizard or appropriate key disk.

Uninstalling licenses or options using the licensing wizard

Restriction: If you installed licenses or options using a key disk, you cannot 
uninstall them using the licensing wizard.

To uninstall a license or option using the licensing wizard

1. Log in to the Empower Enterprise Server or client (with access to the 
appropriate database) as an administrator user.

2. From the Start menu, click Start > Programs > Empower > Waters 
Licensing Wizard.

3. On the Waters Licensing Wizard log on page, enter a user name (one 
that has Administrator privilege) and a password, select the database to 
use, and then click Log On.

4. On the task page, click Deactivate Licenses.

5. On the �Deactivate Licenses � Select Licenses� page, check the option(s) 
you want to deactivate, and then click Next.

6. On the �Deactivate Licenses � Create Deactivation file�, enter a valid 
name and location for your license deactivation file. This file stores your 
license deactivation information. Click Next.

7. When the �Deactivate Licenses � Deactivation file created� page 
appears, note the file location, and then click the address link. 
Tip: If your computer has Internet access, it connects to the Waters 
License Activation Center web site where you complete the deactivation 
process.
Alternative: If your computer does not have Internet access, move the 
license deactivation file that you just created to a computer with 
Internet access so that you can relay your request to Waters. 

8. On the Waters License Activation Center web site, select Deactivate 
Licenses and follow the instructions to deactivate your option(s).
Requirement: You must load the license deactivation file created in step 
7. When the process is complete, a confirmation page appears that lists 
all the licenses and options that have been deactivated.
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Uninstalling licenses or options using key disks

Restrictions: 
� Verify that the disk is not write-protected. 
� If you installed licenses or options using the licensing wizard, you cannot 

uninstall them using a key disk.

To uninstall a license or option using key disks

1. Log in to the Empower Enterprise Server as an administrator user, 
insert the appropriate Empower Option key disk into the disk drive of 
the Enterprise Server or workgroup on which the option is installed, and 
click Start > Run. 

2. In the Run dialog box, type <disk drive>:\Setup.exe, and then click OK. 

3. On the Empower Option Setup page, click OK. 

4. On the Option Already Installed message box, click OK. 

5. On the Setup message box, click OK to close the message box, and then 
remove the key disk. 

Restoring sample (default) projects
If you install a new option, you can use the option sample (default) project files 
as examples for that option. You can restore the sample project files from the 
Empower example projects DVD that came with Empower 2 FR 5 (see 
�Restoring projects� in the Empower Help).

Restricting access to the Message Center properties

In Empower 2 FR 5, the Message Center properties are global for 
Enterprise/Workgroup environments. You must secure them before your 
server goes into production mode. Enable password protection of the Message 
Center properties immediately after installing the database, thus ensuring 
that only authorized persons can modify the properties.

To restrict access to Message Center properties

1. Log in to Empower software with the username of System and the 
password of Manager (Manager is the default password for the 
pre-configured Empower 2 administrator user).
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2. Right-click the Message Center icon in the Sys Tray and select Open.

3. In the Message Center, select View > Properties.

4. Click the Passwords tab. Enable Password Protection, and then enter 
and confirm a password. 
Requirement: Once enabled, users must supply the correct password to 
access the Message Center properties.

Verifying the installed files

The Empower Setup wizard creates an Empower program folder in the Start 
menu Programs folder. The Empower program folder contains the following 
program items:

� Empower Installation Log � Contains information about the current 
installation.

� Empower � Starts the Empower software and displays the Empower 
Login page. After you log in, you can select one of several Empower 
applications. For details, see �Starting and exiting from Empower� in 
the Empower Help.

� Waters Licensing Wizard � Starts the Waters Licensing Wizard, which 
you can use to request software registration, activate and deactivate 
licenses and options, or view Waters licenses and their serial numbers.

� Register Empower Node Printers � Registers printers so that you can 
print Empower reports.

� Verify Files � Verifies the integrity of the Empower software files on 
your hard disk.

Viewing the Install log text
The Install log contains information about your Empower installation. You 
can use the log file to review your installation choices. In case of partial or 
unsuccessful installations, you can view the Install log to check for errors.

To view the install log

1. Select Start > Programs > Empower > Installation Log. 
Result: The program displays the empower.log file in Notepad.
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2. Review the contents of the file. You can print a copy by selecting File > 
Print.

3. Click File > Exit.

Using the file verification utility
The file verification utility checks the integrity of the installed Empower 
program, data, and database files. 
After the installation, run the File Verification utility to verify the Empower 
program and data files only (not the database files):

� As part of your installation qualification, if you purchased the Empower 
Qualification option

� To ensure that the Empower files did not change since installation

To run the file verification utility

1. Select Start > Programs > Empower > Verify Files. 
Result: The file verification utility compares the installed Empower 
files� checksum with a previously stored checksum and then creates a 
file verification results log. 

2. Review the contents of the file. Print or save a copy of the results.

3. Click File > Exit.

Registering printers

To register printers for Empower reports

1. Select Start > Programs > Empower > Register Empower Node Printers. 
Requirement: You must be logged in to the Empower node as an 
administrator or a user with rights enabling you to write to the registry.

2. In the Register Empower Node Printers page, review the list of printers 
that are currently registered.
Tip: The Register Empower Node Printers page shows only printers 
added using the control panel. To add a new printer, click Start > 
Settings > Printers (in Windows Server 2003, Start > Printers and 
Faxes).
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3. If you need to register additional printers, click Get Printers, select the 
printer(s), and then click OK. 

4. Click OK to save the changes, and close the page. 

Checking for Empower service packs

Waters periodically releases service packs to address existing issues or to 
provide enhanced functionality. These service packs are available for 
downloading from the Waters Elite web site and must be installed according 
to the instructions contained in their associated release notes. If you want 
physical media, note the part number from the web site and contact your local 
Waters subsidiary to place an order. 
Tip: If you are using real-time virus scanning, exclude all Empower-related 
folders and their sub-directories. Some real-time virus scanners mistake 
normal Empower functionality for virus activity and can therefore interfere 
with data buffering.
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5 Installing the Empower Oracle 
database on a Solaris server

This chapter explains how to install the Empower 2 Enterprise database 
on a Solaris server.
Requirement: Before installing any hardware or software, perform a full 
backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Introduction

This chapter describes software version information and installation 
guidelines for using a Sun� server to host the Empower database. It is not 
intended to provide installation and configuration instructions for the Sun 
Solaris� operating system or Oracle Enterprise Edition 10.2.0.3 (except for 
Empower-specific items). For information on a Sun server or Solaris 10 
operating system installation, see the Sun Microsystems product 
documentation. For detailed information about configuring the environment 
for the Oracle Enterprise Edition 10.2.0.3 installation, see the Oracle Quick 
Installation Guide.
The Empower 2 software runs in a Microsoft Windows-based environment. 
The Empower 2 UNIX product installs the Oracle database on a Solaris server 
running the Solaris 10 operating system. All other components of the system 
(clients, LAC/E32 modules, and file servers) must run on Windows.

Installing the Empower 2 UNIX product

Waters supplies Oracle software and Empower database software on a DVD. 
Procedures in this chapter assume that you want to install Oracle 
automatically using default settings. Allow approximately 60 minutes to 
install the software. 
If your site already has a supported version of Oracle installed, you may 
choose to install only the Empower 2 database instance. You would start the 
installation at Part 2 (see �Installing the Empower 2 database instance� on 
page 5-4) and skip Part 1.
The Empower 2 UNIX product includes two separate installers for proper 
installation and configuration of the Oracle 10.2.0.1 application and the 
Empower 2 database instance on a UNIX server. You must set certain 
environmental conditions before each installation.
To install Oracle 10.2.0.3 and create an Empower 2 database instance on a 
UNIX server, you must perform these tasks:

� Prepare the Solaris 10 operating environment using the Oracle Quick 
Installation Guide as a reference.

� Install Oracle Enterprise 10.2.0.1 application (Installation Part 1).
� Install the Oracle Enterprise 10.2.0.3 patch
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� Configure the system before installing the Empower 2 database 
instance.

� Install the database instance (Installation Part 2).
� Configure the database (set up a Listener and enter the ORACLE_SID).
� Set the database to start on reboot.

Preparing the Solaris 10 operating environment
Install the Solaris 10 operating system and all required service packs 
according to the documentation provided by the manufacturer and your IT 
department.
Prepare the Solaris 10 environment for the Oracle 10.2.0.1 database 
installation according to the procedures outlined in the Oracle Quick 
Installation Guide.
Requirement: Remove any ORACLE_SID references that may be set in the 
.profile file before launching the installer.

Installing the Oracle Enterprise application 10.2.0.1
Once the Solaris operating environment has been installed and prepared, you 
can install the Oracle 10.2.0.3 database.

To install the Oracle 10.2.0.1 application (Installation Part 1)

1. Log in as the Oracle user, and open a terminal window.

2. Change directory to the root of the DVD, and execute one of the following 
commands:
java -jar oraclesparc.jar

or
java -cp oraclesparc.jar run

3. Wait for the Waters installer to launch and install the Oracle software.
Result: When the Oracle installation is finished, the installer will 
prompt you to log in as root and run the root.sh script.

4. Run the root.sh script and return to the installer to finish Part 1 of the 
installation and exit.

5. Install the Oracle 10.2.0.3 patch. 
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Tip: The patch CD, �Emp.2 Oracle 10.2.0.3 for Solaris 10�, is available 
from your local Waters subsidiary.

Configuring the system before installing the database instance
Before you install the database instance, ensure there are no instances of 
ORACLE_SID in the .profile file and that ORACLE_HOME is set properly in 
your environment. The .profile MUST be correct for the installation to work.

To verify that no ORACLE_SID exists

In a terminal window, enter the following command:
echo $ORACLE_SID

This command should return blank, indicating there is no SID set. If a SID 
does exist, remove it from the file.

To verify that Oracle home is set properly

1. Enter the following command to ensure that ORACLE_HOME is set 
properly:
echo $ORACLE_HOME

This should return the correct path for your Oracle home. If the correct 
path is not in your environment, add the appropriate information to the 
.profile file
Example:
ORACLE_HOME=/u01/app/oracle/product/10.2.0.3/empower

export ORACLE_HOME

2. Log out, and then log in again.

Installing the Empower 2 database instance
The drives for the data paths must be mounted in advance, and the folders 
must be already created before you launch the installer. During configuration, 
you will be asked to provide the correct path to these data folders.

To install the Empower 2 database instance (Installation part 2)

1. Change directory to the root of the DVD, and execute one of the following 
commands:
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java -jar empowerdb.jar

or 
java -cp empowerdb.jar run

2. Wait for the installer to launch, and follow the screen prompts. 
Result: The installer prompts you to verify the ORACLE_BASE and 
ORACLE_HOME paths. If the paths are correct, click Next. 
Requirement: The paths must match your environmental settings for 
ORACLE_BASE and ORACLE_HOME as specified in the .profile file. If 
the paths do not match, exit the installer and fix the environment. Then 
log out, log in, and try the installation again.

Configuring the database
On the Database Options page, enter the Oracle SID, the global database 
name, and the data paths, following these guidelines:

� The SID is case-sensitive and must be less than 8 alpha-numeric 
characters. Do not use any special characters.

� The Global Database Name must not contain dashes (-).
� The default Global Database Name is your sid.servername. If your 

server name contains dashes, remove them.
� Enter the correct path to the data folders using the drives that were 

mounted previously.
� Modify any values as necessary, and then click next. 
� You may be prompted to change the system account passwords. Do 

not change these passwords. Click OK to continue without making 
any changes.

The installation and configuration process takes approximately 40 minutes, 
depending on the machine. Wait until the installer finishes. The process 
creates the Empower instance and the Empower 2 database. 
Restriction: The installation is not complete until you update the database to 
Empower 2 FR 5 by connecting to it from an FR 5 client.
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Setting the database to start on reboot

To set up the database to start on reboot

1. Open the .profile file, and set the Oracle SID and ORAENV variables. 
For example:
ORACLE_SID=WATB export ORACLE_SID
ORAENV_ASK=NO
export ORAENV_ASK
. oraenv

Tip: WATB is an example SID. Your Oracle SID will differ.

2. Change the oratab file to say Yes to the Oracle SID in your environment. 
For example:

    WATB:/u01/app/oracle/product/10.2.0.3/empower:Y 

Tip: The oratab file is located in the /var/opt/oracle folder.

3. Include dbora in the /etc/init.d folder, and run the following commands 
to link the start/shutdown actions:
ln -s /etc/init.d/dbora /etc/rc0.d/K01dbora

ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora

Requirement: You must type the commands exactly as indicated for the 
actions to work.
Tips:
� A sample dbora file is provided in the sample scripts folder on the 

product DVD.
� K01 in front of the dbora name signifies to Kill the Oracle processes 

first on shutdown.
� S99 in front of the second command means Start the Oracle 

processes last on reboot.

4. Log out and log in again, and then verify that you can log in to the 
server.
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Completing the installation

To complete the installation, you must perform these tasks:

1. Configure the Empower 2 FR 5 client with the appropriate server 
connection information (see Chapter 6, �Installing an Empower client�.)

2. On the client, log in to Empower using an account with Empower 
Administrator privileges.

3. At the �Database needs to be updated� prompt, click OK.
Tip: If you connect to the Solaris database from an Empower 2 FR 5 
client before you add the Enterprse base license, you will not be 
prompted for a password. If you install the Enterprise base license 
before the first login, then you will be prompted to enter a password.

4. At the password prompt, enter the following password exactly as it 
appears here (you must use all capital letters):
EMPOWERCSUPDATE

5. Click OK.

6. Install the Empower 2 FR 5 file server (see Chapter 8, �Installing an 
Empower file server�.)
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6 Installing an Empower client

This chapter explains how to install the Empower 2 FR 5 software on a 
client (or an acquisition client) in an Empower Enterprise system or a 
Workgroup. 
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Preparing the client

Empower 2 FR 5 software on a client using Windows XP SP2 or Windows 
Vista Enterprise SP1 requires the hardware and software specified in the 
table titled �Requirements for Empower Personal or client computers, LAC/E 
modules� on page 1-6.
Tip: See the Microsoft Web site (www.microsoft.com) or the relevant product 
DVD for software and upgrades.
Recommendation: If you plan to change the computer name of a client, 
Waters recommends that you change the name before installing Empower 
software.
Take these actions to prepare a client:

� Change the page file size (see �Changing the page file size� on page 6-2) 
� Configure the event viewer to overwrite events as needed (see 

�Configuring the Event Viewer� on page 6-3)
� Ensure the Windows Vista Enterprise client is a member of the domain 

in which Empower is running (see �Verifying the Empower domain� on 
page 6-4)
Requirement: If you change domains after installing Empower and any 
instrument control option packs (ICOPs), you must manually change the 
firewall exceptions list, as firewall settings do not carry over from one 
domain to another.

Changing the page file size
Empower 2 FR 5 software requires a minimum page file size of 1024 MB on 
Windows XP. For Windows Vista, configure the system so that the virtual 
memory setting automatically manages the paging file size.

To change the page file size in Windows XP

1. In Windows Explorer, right-click My Computer, click Properties, and 
then click the Advanced tab.

2. On the System Properties page, in the Performance panel, click Settings, 
and on the Performance Options page, click the Advanced tab. 
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3. On the Virtual Memory panel, if the page size is already 1024 MB or 
greater, click Cancel (you need not change the size). Continue with 
�Configuring the Event Viewer� on page 6-3.
If the page size is less than 1024 MB, click Change.

4. On the Virtual Memory page, under Paging File Size for selected drive, 
enter a minimum of 1024 in Initial size (MB) and a minimum of 1024 in 
Maximum size (MB), and then click Set. 

5. On the Virtual Memory, Performance Options, and System Properties 
page, click OK, and then restart the computer.

To automatically manage the page file size in Windows Vista Enterprise

1. In Windows Explorer, right-click Computer, and then click Properties.

2. Click Advanced System Settings. 
Tip: If a Permission screen appears, click Continue.

3. On the System Properties page, click the Advanced tab.

4. On the Performance panel, click Settings.

5. Click the Advanced tab. 

6. On the Virtual Memory page, click Change. 

7. On the Virtual Memory page, select the check box for �Automatically 
manage paging file size for all drives�, and then click OK.

Configuring the Event Viewer

To configure Event Viewer

1. Right-click My Computer, and then click Manage.

2. In the System Tools tree, click Event Viewer. 

3. Right-click Application, and then click Properties.

4. On the Application Log Properties page, on the General tab, click 
�Overwrite events as needed�, click Apply, and then click OK.

5. Repeat step 3 through step 4 for Security and System.

6. Close the Event Viewer page.
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Verifying the Empower domain

To view the domain currently being used for Empower

1. Click Start > Control Panel, and then double-click System.

2. Click the Computer Name tab and note the domain name that appears 
below the full computer name.

Installing the Empower 2 FR 5 software

Waters supplies Empower 2 FR 5 software on a DVD. 
Exception: If you are performing an upgrade, do not continue with this 
procedure. See the Empower 2 Feature Release 5 Upgrade Guide, Revision A 
for upgrade procedures.
You can perform a typical installation to install the software on drive C or 
default location, or a custom installation to specify a different drive.
By default, the Empower 2 FR 5 installer installs both the Oracle 10.2.0.3 
client and Empower 2 FR 5. If your site has its own Oracle license and prefers 
to install Oracle 10.2.0.3 as a separate application, consider these installation 
issues:

� Install Oracle 10.2.0.3 Enterprise Client software prior to installing 
Empower 2.

� The HKEY_LOCAL_MACHINE\Software\Oracle\NLS_Lang registry 
key value must be changed to AMERICAN_AMERICA.WE8ISO8859P1.

� The permissions on the Oracle Home directory (and sub-directories) 
must be changed to allow the Group Users all rights except for Full 
Control.

� During installation, you are asked whether you want to use your 
installed Oracle software. Select Yes and supply the location of the 
Oracle program files.

Requirement: If you are using Mass Spectrometry instruments, make sure 
you have IIS and FTP installed before continuing to install Empower. See 
�Configuring mass spectrometers� on page 2-20.
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Installing Empower 2 FR 5 software

To start the Empower 2 FR 5 installation

1. Browse to the Client folder on the Empower 2 FR 5 DVD and 
double-click EmpowerClientFR5setup.exe.

2. On the Choose Setup Language page, select a language from the 
drop-down list.
Requirement: If Microsoft .NET Framework 3.0 software is installed on 
your system, the installation continues. However, if the software is not 
installed, the Requirement wizard page appears. On that page, click 
Install.

3. On the Welcome page, click Next.

4. On the License Agreement page, accept the license agreement, and then 
click Next.

5. On the Customer Information page, enter your user name, organization, 
and serial number, and then click Next.

6. On the Setup Type page, leave Typical selected. 
Alternative: Select Custom if you want to install the software on a drive 
other than C, then continue with �Finishing a custom installation� on 
page 6-7.

7. Verify that the correct Empower Installation Type (Client) is selected, 
and then click Next.
If you selected Typical, continue with the next section.

To configure a typical installation

1. On the Installation Options page, make the following selections:
In the TNS_ADMIN environment variable field, you have the option of 
setting the TNS_ADMIN environment variable. This variable setting 
adds an environmental variable to the client that points to a 
preconfigured tnsnames.ora file, which is located in a network-accessible 
share. This option allows large installations to maintain a single 
tnsnames.ora file in a share instead of configuring a tnsnames.ora file on 
each client computer. 
� If you do not intend to use this configuration option, leave No 

selected, and then click Next.
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� If you want to enable the TNS_ADMIN variable, select Yes, enter 
the network path to the share containing the preconfigured 
tnsnames.ora file (for example, \\servername\sharename$), and 
then click Next. (Use the TNS_ADMIN directory that was set in 
�Configuring a shared tnsnames.ora file� on page 4-9.)
Rule: If the TNS_ADMIN environmental variable is set, the client 
disregards local tnsnames.ora files.

2. On the Ready to Install the Program page, click Install to start the 
installation.

3. On the Installation is Complete page, click �Yes, I want to restart my 
computer now�, and then click Finish. 

4. After the computer restarts, log in using an account with Administrator 
privileges. 

5. If you are not using the TNS_ADMIN environmental variable, see 
�Configuring a database net service name� on page 6-9 to configure a 
local tnsnames.ora file.

6. If you want to install software support for one or more instruments, use 
the Waters Instrument Control Options Pack (ICOP) installation DVD. 
Browse to the appropriate language folder on the DVD, locate the 
setup.exe file, and then double-click the file (for Windows Vista, 
right-click the file and then select �Run as Administrator�). Follow the 
prompts to install the software support you need.

Tip: If you experience instrument communication problems, check the firewall 
exceptions list. In Control Panel, double-click Windows Firewall, and then 
click the Exceptions tab. Ensure the following exceptions are checked in the 
Programs and Services list:

� Empower-related ports and processes:
� DCOM Port
� Empower
� Empower Configuration Manager
� Processing Monitor
� Processing Server
� Waters DHCP Server Configuration
� Waters Instrument Server
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� Waters Service
� WDHCP Server Svc.exe

� Instrument control software-related processes:
� ACQUITY Console Client
� ACQUITY Console Server
� Trinity UI (if applicable)
� Waters File Service (if applicable)

Finishing a custom installation
If you selected Custom in step 6 on page 6-5, verify that the correct Empower 
Installation Type (Client) is selected, and then click Next. Complete the 
installation as follows.

To configure a custom installation

1. On the Custom Setup page, specify installation drives for the application 
components. By default, all locations point to the C drive. 
To designate drives other than C, select a feature (for example, Oracle 
Application), and then click the Change Feature Location button.

2. On the Change Current Destination Folder page, select the desired 
drive, and then click OK to return to the Custom Setup page. Click Next.

3. On the Installation Options page, make the following selections:
In the TNS_ADMIN environment variable field, you have the option of 
setting the TNS_ADMIN environment variable. This variable setting 
adds an environmental variable to the client that points to a 
preconfigured tnsnames.ora file, which is located in a network-accessible 
share. This option allows large installations to maintain a single 
tnsnames.ora file in a share instead of configuring a tnsnames.ora file on 
each client computer. 
� If you do not intend to use this configuration option, leave No 

selected, and then click Next.
� If you want to enable the TNS_ADMIN variable, select Yes, enter 

the network path to the share containing the preconfigured 
tnsnames.ora file (for example, \\servername\sharename$), and 
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then click Next. (Use the TNS_ADMIN directory that was set in 
�Configuring a shared tnsnames.ora file� on page 4-9.)
Rule: If the TNS_ADMIN environmental variable is set, the client 
disregards local tnsnames.ora files.

4. On the Ready to Install the Program page, click Install to start the 
installation.

5. On the Installation is Complete page, click �Yes, I want to restart my 
computer now�, and then click Finish. 

6. After the computer restarts, log in using an account with Administrator 
privileges.

7. If you are not using the TNS_ADMIN environmental variable, follow the 
procedure in the next section (�Configuring a database net service 
name�) to configure a local tnsnames.ora file.

8. If you want to install software support for one or more instruments, use 
the Waters Instrument Control Options Pack (ICOP) installation DVD. 
Browse to the appropriate language folder on the DVD, locate the 
setup.exe file, and then double-click the file (for Windows Vista, 
right-click the file and then select �Run as Administrator�). Follow the 
prompts to install the software support you need.

Tip: If you experience instrument communication problems, check the firewall 
exceptions list. In Control Panel, double-click Windows Firewall, and then 
click the Exceptions tab. Ensure the following exceptions are checked in the 
Programs and Services list:

� Empower-related ports and processes:
� DCOM Port
� Empower
� Empower Configuration Manager
� Processing Monitor
� Processing Server
� Waters DHCP Server Configuration
� Waters Instrument Server
� Waters Service
� WDHCP Server Svc.exe
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� Instrument control software-related processes:
� ACQUITY Console Client
� ACQUITY Console Server
� Trinity UI (if applicable)
� Waters File Service (if applicable)

Configuring a database net service name

You must configure a net service name (previously called a database alias) on 
each client to connect to the Empower database unless you are using the 
TNS_ADMIN environment variable. 
Tip: The TNS_ADMIN variable is set during installation, and a tnsnames.ora 
file is created. The TNS_ADMIN variable points to the tnsnames.ora file.
Use the following procedure to create a new service name or modify the 
existing net service name.

To configure a net service name

1. Select Start > Programs > Oracle - Empower102 > Configuration and 
Migration Tools > Net Configuration Assistant.

2. On the Net Configuration Assistant wizard Welcome page, select �Local 
Net Service Name configuration�, and then click Next. 

3. On the Net Service Name Configuration page, ensure that Add is 
selected, and then click Next.

4. On the Service Name page, enter the global database name, and then 
click Next. 
Tip: The global database name is the combination of the Oracle Service 
Identifier (SID) and the database domain name, as supplied during 
installation.
Example: If the SID is WAT7 and the database domain name is 
Empower1.Waters.com, the global database name is 
WAT7.Empower1.Waters.com.

5. On the Select Protocols page, ensure that TCP/IP is selected, and then 
click Next.
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6. On the TCP/IP Protocol page, enter either the host name or the IP 
address of the server in the Host Name field. 

7. Leave the default port selection at 1521, and then click Next.

To test the connection

1. On the test page, select �Yes, perform a test�, and then click Next.
Result: The test will fail, indicating the �ORA-01017 � invalid 
username/password� error. If the failure is associated with any error 
other than ORA-01017, contact Waters Technical Support.

2. Click Change Login. On the Change Login page, enter System in the 
Username field and Empower in the Password field. �Empower� is the 
default password for the Oracle System account in Empower 2. Click 
OK.

To specify the net service name

1. On the Net Service Name page, enter a name in the Net Service Name 
field, and then click Next. 
Requirement: The name that you enter appears in the Database field of 
the Empower Login page. When using a client with a LAC/E32 module, 
the client and the module must use the identical net service name.

2. On the �Another Net Service Name?� page, Select No, click Next until 
the Welcome page of the Oracle Net Configuration Assistant wizard 
appears, and then click Finish. 

Registering printers

To register printers for Empower reports

1. Select Start > Programs > Empower > Register Empower Node Printers. 
Requirement: You must be logged in to the Empower node as an 
administrator or a user with rights enabling you to write to the registry.

2. On the Register Empower Node Printers page, review the list of printers 
that are currently registered.
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Tip: The Register Empower Node Printers page shows only printers 
added using the control panel. To add a new printer, click Start > 
Settings > Printers.

3. If you need to register additional printers, click Get Printers, select the 
printer(s), and then click OK. 

4. Click OK to save the changes, and close the page. 

Checking for Empower service packs

Waters periodically releases service packs to address existing issues or to 
provide enhanced functionality. These service packs are available for 
downloading from the Waters Elite web site and must be installed according 
to the instructions contained in their associated release notes. If you want 
physical media, note the part number from the web site and contact your local 
Waters subsidiary to place an order. 
Tip: If you are using real-time virus scanning, exclude all Empower-related 
folders and their sub-directories. Some real-time virus scanners mistake 
normal Empower functionality for virus activity and can therefore interfere 
with data buffering.
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7 Installing a LAC/E32 Module

This chapter explains how to install the Empower 2 FR 5 software on 
Waters LAC/E32 modules. To install Empower 2 FR 5 software on an 
acquisition client, follow the installation instructions in Chapter 6.
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Preparing a LAC/E32 module

Each LAC/E32 module requires the hardware and software in the table titled 
�Requirements for the Windows database server� on page 1-7. Normally, 
Waters installs the software before shipping the system to you. 

Follow these procedures to prepare a LAC/E32 module:

� Connecting remotely to a LAC/E32 module (see Appendix A)
� Updating the Equinox driver (see �Updating the Equinox driver� on 

page 7-2)
� Changing the page file size (see �Changing the Page File size� on 

page 7-3)
� Configuring the event viewer (see �Configuring the Event Viewer� on 

page 7-4)

Connecting remotely
Use the Remote Desktop feature of Windows Vista or Windows XP to access 
your LAC/E32 module from a remote location.

Updating the Equinox driver
Restriction: The Equinox driver is not supported on Windows Vista.
Empower for Windows XP supports only Equinox driver version 5.40.0.0. If 
the Empower node has an Equinox 8-port serial interface card, Windows 
detects it during the first power-up after installing the serial card, and 
automatically installs a driver for the Equinox card. Check the driver version 
and install v. 5.40.0.0, if needed. If your Empower node does not have an 
Equinox driver, continue with �Changing the Page File size� on page 7-3.

To verify the Equinox driver version

1. Select Start > Settings > Control Panel and double-click System.

2. Click the Hardware tab, and then click Device Manager.

3. On the Device Manager page, click the plus sign to the left-hand side of 
�Multi-port serial adapters�. 
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4. Right-click Equinox SST-8P PCI Adapter, select Properties, and verify 
the driver version is 5.40.0.0. 
Tip: If the version is not 5.40.0.0, click Update Driver.

To update the Equinox driver version

1. On the Hardware Update Wizard Welcome page (which appears when 
you click Update Driver in step 4 above), select �Install from a list or 
specific location (Advanced)�, and then click Next.

2. On the Choose your search and installation options page, select �Don�t 
search. I will choose the driver to install�, and then click Next. 

3. On the �Select the device driver you want to install for this hardware� 
page, click Have disk. 

4. On the Install From Disk page, type (or browse to) C:\EQN, and then 
click OK.

5. On the �Select the device driver you want to install� page, ensure that 
�Show compatible hardware� is selected, and then click Next.

6. If a Hardware Installation Warning page appears, click Continue 
Anyway to continue the installation.
Tip: Although not digitally signed for this release of Windows XP, 
Equinox driver v. 5.40.0.0 is the correct driver for Empower.

7. On the Completing the Hardware Update Wizard page, click Finish.

8. On the Equinox SST-8P PCI Adapter Properties page, click Close, and 
then restart the computer.

Changing the Page File size
Empower requires a minimum page file size of 1024 MB.

To change the page file size

1. In Windows Explorer, right-click My Computer, click Properties, and 
then click the Advanced tab.

2. On the System Properties page, in the Performance panel, click Settings, 
and on the Performance Options page, click the Advanced tab. 

3. In the Virtual Memory panel, take one of the following actions:
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� If the page size is already 1024 MB or greater, click Cancel (you 
need not change the size), and continue with �Configuring the Event 
Viewer�.

� If the page size is less than 1024 MB, click Change, and continue 
with the next step.

4. On the Virtual Memory page, under Paging File Size for selected drive, 
enter a minimum of 1024 in Initial size (MB) and a minimum of 1024 in 
Maximum size (MB), and then click Set. 

5. Click OK on the Virtual Memory, Performance Options, and System 
Properties page, and then restart the computer.

Configuring the Event Viewer

To configure Event Viewer

1. Right-click My Computer, and then click Manage.

2. In the System Tools tree, click Event Viewer. 

3. Right-click Application, and then click Properties.

4. On the Application Log Properties page, on the General tab, click 
�Overwrite events as needed�, click Apply, and then click OK.

5. Repeat step 3 and step 4 for Security and System.

6. Close the Event Viewer page.

Installing the Empower 2 FR 5 software

By default, the Empower 2 FR 5 installer installs both the Oracle 10.2.0.3 
client and Empower 2 FR 5. If your site has its own Oracle license and prefers 
to install Oracle 10.2.0.3 as a separate application, consider these installation 
issues:

� Install Oracle 10.2.0.3 software only (without a database) prior to 
installing Empower 2.

� The HKEY_LOCAL_MACHINE\Software\Oracle\NLS_Lang registry 
key value must be changed to AMERICAN_AMERICA.WE8ISO8859P1.
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� During installation, you are asked if you want to use your installed 
Oracle software. Select Yes and supply the location of the Oracle 
program files.

Waters supplies Empower 2 FR 5 software on a DVD. 

Installing Empower 2 FR 5 software

To install Empower 2 FR 5 on the LAC/E32 module

1. Insert the Empower 2 FR 5 DVD into the DVD drive. 

2. Browse to the Client folder on the Empower 2 FR 5 DVD and 
double-click EmpowerClientFR5setup.exe

3. On the Choose Setup Language page, select a language from the 
drop-down list.
Requirement: If Microsoft .NET Framework 3.0 software is installed on 
your system, the installation continues. However, if the software is not 
installed, the Requirement wizard page appears. On that page, click 
Install.

4. On the Welcome page, click Next.

5. On the License Agreement page, accept the license agreement, and then 
click Next.

6. On the Customer Information page, enter your user name, organization, 
and serial number, and then click Next.

7. On the Setup Type page, select Custom if you want to install the 
software on a drive other than C. Otherwise, leave Typical selected. 

8. Verify that the correct Empower Installation Type (LAC/E32) is selected, 
and then click Next.
If you selected Custom, continue with �Finishing a custom installation� 
on page 7-6.
If you selected Typical, continue with the next section.

To configure a typical installation

1. On the Installation Options page, make the following selections:
In the TNS_ADMIN environment variable field, you have the option of 
setting the TNS_ADMIN environment variable. This variable setting 
Installing the Empower 2 FR 5 software 7-5



adds an environmental variable that points to a preconfigured 
tnsnames.ora file, which is located in a network-accessible share. This 
option allows large installations to maintain a single tnsnames.ora file 
in a share instead of configuring a tnsnames.ora file on each LAC/E32 

module. 
� If you do not intend to use this configuration option, leave No 

selected, and then click Next.
� If you want to enable the TNS_ADMIN variable, select Yes, enter 

the network path to the share containing the preconfigured 
tnsnames.ora file (for example, \\servername\sharename$), and 
then click Next. (Use the TNS_ADMIN directory that was set in 
�Configuring a shared tnsnames.ora file� on page 4-9.)
Rule: If the TNS_ADMIN environmental variable is set, the LAC/E 
disregards local tnsnames.ora files.

2. On the Ready to Install the Program page, click Install to start the 
installation.

3. When the installation is complete, restart the LAC/E32 module and log in 
to the operating system as the local administrator. 

4. If you are not using the TNS_ADMIN environmental variable, see 
�Configuring a database net service name� on page 7-8 to configure a 
local tnsnames.ora file.

5. If you want to install software support for one or more instruments, use 
the Waters Instrument Control Options Pack (ICOP) installation DVD. 
Browse to the appropriate language folder on the DVD, locate the 
setup.exe file, and then double-click the file. Follow the prompts to 
install the software support you need.

Finishing a custom installation
If you selected Custom in step 7 on page 7-5, complete the installation as 
follows.

To configure a custom installation

1. On the Custom Setup page, specify installation drives for the application 
components. By default, all locations point to the C drive.
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To designate drives other than drive C, select a feature (for example, 
Empower Oracle Files and Database), and then click the Change 
Feature Location button.

2. On the Change Current Destination Folder page, select the desired 
drive, and then click OK to return to the Custom Setup page. 

3. On the Installation Options page, make the following selections:
In the TNS_ADMIN environment variable field, you have the option of 
setting the TNS_ADMIN environment variable. This variable setting 
adds an environmental variable that points to a preconfigured 
tnsnames.ora file, which is located in a network-accessible share. This 
option allows large installations to maintain a single tnsnames.ora file 
in a share instead of configuring a tnsnames.ora file on each LAC/E32 

module. 
� If you do not intend to use this configuration option, leave No 

selected, and then click Next.
� If you want to enable the TNS_ADMIN variable, select Yes, enter 

the network path to the share containing the preconfigured 
tnsnames.ora file (for example, \\servername\sharename$), and 
then click Next. (Use the TNS_ADMIN directory that was set in 
�Configuring a shared tnsnames.ora file� on page 4-9.)
Rule: If the TNS_ADMIN environmental variable is set, the server 
disregards local tnsnames.ora files.

4. On the Ready to Install the Program page, click Install to start the 
installation.

5. On the Installation is Complete page, click �Yes, I want to restart my 
computer now�, and then click Finish. 

6. After the computer restarts, log in using an account with Administrator 
privileges.

7. If a Command Prompt window and a Registry Editor message box 
appear, click OK to close the message box. 

8. If you want to install software support for one or more instruments, use 
the Waters Instrument Control Options Pack (ICOP) installation DVD. 
Browse to the appropriate language folder on the DVD, locate the 
setup.exe file, and then double-click the file. Follow the prompts to 
install the software support you need.
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Configuring a database net service name

You must configure a net service name (previously called a database alias) on 
each LAC/E32 module to connect to the Empower database, unless you are 
using the TNS_ADMIN environment variable. 
Tip: The TNS_ADMIN variable is set during installation, and a tnsnames.ora 
file is created. The TNS_ADMIN variable points to the tnsnames.ora file.
Use the following procedure to create a new service name or modify the 
existing net service name.

To configure a net service name

1. Select Start > Programs > Oracle � Empower102 > Configuration and 
Migration Tools > Net Configuration Assistant.

2. On the Net Configuration Assistant wizard Welcome page, select �Local 
Net Service Name configuration�, and then click Next. 

3. On the Net Service Name Configuration page, ensure that Add is 
selected, and then click Next.

4. On the Service Name page, enter the global database name, and then 
click Next. 
Tip: The global database name is the combination of the Oracle Service 
Identifier (SID) and the database domain name, as supplied during 
installation.
Example: If the SID is WAT7 and the database domain name is 
Empower1.Waters.com, the global database name is 
WAT7.Empower1.Waters.com.

5. On the Select Protocols page, ensure that TCP/IP is selected, and then 
click Next.

6. On the TCP/IP Protocol page, enter the host name or the IP address of 
the server in the Host Name field. Leave the default port selection at 
1521, and then click Next.

To test the connection

1. On the test page, select �Yes, perform a test,� and then click Next.
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Result: The test will fail, indicating the �ORA-01017 � invalid 
username/password� error. If the failure is associated with any error 
other than ORA-01017, contact Waters Technical Support.

2. Click Change Login. On the Change Login page, enter System in the 
username field and Empower in the password field. (�Empower� is the 
default password for the Oracle System account in Empower 2 FR 5.) 

3. Click OK.

To specify the net service name

1. On the Net Service Name page, enter a name in the Net Service Name 
field, and then click Next. 
Requirement: The name that you enter appears in the Database field of 
the Empower Login page. When using a client with a LAC/E32module, 
the client and the module must use the identical net service name.

2. On the �Another Net Service Name?� page, Select No, click Next until 
the Welcome page of the Oracle Net Configuration Assistant wizard 
appears, and then click Finish. 

Registering printers

To register printers for Empower reports

1. Select Start > Programs > Empower > Register Empower Node Printers. 
Requirement: You must be logged in to the Empower node as an 
administrator or a user with rights enabling you to write to the registry.

2. On the Register Empower Node Printers page, review the list of printers 
that are currently registered.
Tip: The Register Empower Node Printers page shows only printers 
added using the control panel. To add a new printer, click Start > 
Settings > Printers.

3. If you need to register additional printers, click Get Printers, select the 
printer(s), and then click OK. 

4. Click OK to save the changes, and close the page. 
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Setting the LAC/E32 time zone

Empower records the date and time of data acquisition and processing for 
different countries and time zones.
Requirement: Always restart the LAC/E32 module after the following 
conditions: 

� You change the time zone of the operating system

� The LAC/E32 drops its network connection 

If either of these conditions occurs and you do not restart the LAC/E32, the 
time stamps on all injections acquired during buffering can be displayed 
incorrectly. Changes made to the operating system time zone setting do not 
take effect until the LAC/E32 is restarted.

To specify the time zone for the LAC/E32

1. Log in to Empower software as an administrator from any client.

2. Access Configuration Manager, and click Empower Nodes.

3. Right-click the LAC/E32, and select Empower Node Properties.

4. Select the appropriate time zone for the LAC/E32, and then click OK.

Checking for Empower service packs

Waters periodically releases service packs to address existing issues or to 
provide enhanced functionality. These service packs are available for 
downloading from the Waters Elite web site and should be installed according 
to the instructions contained in their associated release notes. If you want 
physical media, note the part number from the web site and contact your local 
Waters subsidiary to place an order. 
Tip: If you are using real-time virus scanning, exclude all Empower-related 
folders and their sub-directories. Some real-time virus scanners mistake 
normal Empower functionality for virus activity and can therefore interfere 
with data buffering.
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8 Installing an Empower file server

This chapter explains how to install the Waters Service as a separate 
service on a server other than the Empower 2 FR 5 database server.
Recommendation: Before installing any hardware or software, perform 
a full backup of your hard drives (see the instructions provided by the 
manufacturer of your computer).
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Considerations and requirements

Considerations
The Waters Service allows computers on which it is installed to have raw data 
shares configured in Empower software. Users can store project raw data on 
these file shares. The service provides secure access to Empower software raw 
data files through the Empower application. While the operating system 
permissions on the files can be set to read-only for Empower users, these same 
users can have write privileges through the WatersService when running 
Empower software.
If you are using real-time virus scanning, exclude all Empower-related folders 
and their sub-directories. Some real-time virus scanners mistake normal 
Empower functionality for virus activity and can therefore interfere with data 
buffering.

Requirements
� Valid client and server network connections
� Windows Server 2003 or Windows 2000 Server

Restriction: Windows XP is supported on a file server; however, the 
number of incoming connections is limited to 10.

Installing the Waters Service 

Requirement: Before continuing with the installation procedure, verify that 
all logs in the Event Viewer are set to �Overwrite events as needed�. (See 
�Configuring the Event Viewer� on page 6-3).

To install the WatersService on a server on which Empower software is not 
loaded

1. Insert the Empower 2 FR 5 DVD into the DVD drive. 

2. On the DVD, browse to the Options folder, then the WatersService 
folder, and then double-click the WaterServiceSetup.exe file.

3. On the Welcome page, click Next. 

4. On the Custom Setup page, select Waters Service, and then click Next. 
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5. On the Empower Raw Data Share page, select the default name 
(Waters_Projects$) or customize the name, and then click Next. 
Requirement: If you customize the name, you must use the same share 
name for the raw data files share (see the next section, �Creating the 
raw data share in Empower�). You must also put a $ on the end of the 
name to hide the share from network browsing.

6. On the Ready to Install the Program page, click Install. 

7. On the InstallShield Wizard Completed page, click Finish.

Creating the raw data share in Empower

To create the raw data share

1. Log in to Empower 2 FR 5 as an administrator user and access 
Configuration Manager. 

2. In Configuration Manager, click View > Manage Raw Data Files. 

3. Click Add File Service. 

4. In the Node Name field, enter the name or IP address of the file server 
on which you installed Waters Service in the previous section.

5. Click Test to verify that the file server is reachable and properly 
configured. Click OK at the �File server valid� message box. 
Tip: If the test reported the file server is invalid, check your entry in the 
Node Name field. Make any necessary corrections and repeat the test. If 
the file server is still reported invalid, the cause can be configuration 
errors on the file server. 

6. Click Add Raw Data Share.

7. On the Add Empower Raw Data Share page, enter the name of the raw 
data share you created in step 5 of the procedure you used to install the 
WatersService (see above). 
If the share name you entered was not pre-configured on the file server, 
you are prompted to enter a directory path for the raw data share. Enter 
the path (for example, C:\QALab\Projects), and then click OK.
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Configuring raw data directory permissions

The raw data share on the file server is created with default security settings 
supplied by the installed operating system. To ensure the proper level of 
access and security, the security permissions must be set exactly as described 
in �Configuring the Empower Projects directory� on page 4-10, in this guide.
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9 Configuring Empower software 
in a Citrix Presentation Server� 
environment

Refer to this chapter when installing Empower 2 FR 5 in a Citrix 
Presentation Server environment.
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Introduction

To access Empower 2 FR 5 in a Citrix Presentation Server environment, the 
Empower 2 FR 5 client is loaded onto the Citrix terminal server. Client 
computers can then connect to the Citrix server to access and operate 
Empower 2 FR 5. Clients access Empower using the Independent Computing 
Architecture (ICA®) protocol developed by Citrix.
You can also use the Citrix Web Interface Server to provide web-based access 
to Citrix Empower servers.
Requirement: Empower 2 FR 5 must be the only application running on your 
Citrix server. Do not run non-Empower applications on your Citrix server.
For information on installing and configuring a Citrix server, contact Citrix.

Configuring the Citrix server for Empower 

To use the Citrix server with Empower 2 FR 5 clients, first verify that you are 
using the required Microsoft operating system and version, and ensure that 
Citrix Presentation Server 4.0 or 4.5 software is installed on the server. Then 
set the system up as follows:

� Uninstall any existing ICOP, ICS, or AQT software, if applicable, using 
the Add/Remove program.

� Uninstall any previous versions of Empower software.
� Configure Event Viewer.
� Install the Empower 2 FR 5 client on the Citrix server.
� Disable WatersService.
� Configure database net service names.
� Publish Empower.

Uninstalling previous instrument control and Empower software
If you have previous versions of instrument control option packs (ICOPs), 
instrument control software (ICS), AQT software, or Empower software on 
your Citrix server, you must uninstall the software using the Add/Remove 
program. Uninstall the components in the following order:

1. Uninstall any ICOPs or ICS, if applicable.
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2. Uninstall any AQT software, if applicable.

3. Uninstall the Empower client.
Requirement: When you uninstall Empower, you must also manually delete 
the old milerror.log file from the Windows directory. Since this file contains 
information about prior error conditions which may no longer exist with a new 
installation of Empower, deleting the milerror.log file prevents any 
non-existent error conditions from being included in Verify Files. Any 
subsequent error conditions that occur with the new Empower installation are 
then accurately captured in Verify Files.

Configuring Event Viewer

To configure Event Viewer

1. Click Start > Programs > Administrative Tools > Event Viewer.

2. On the Event Viewer page, in the Tree tab, right click Application Log, 
and select Properties.

3. On the Application Log Properties page, select �Overwrite events as 
needed�, select Apply, and then click OK.

4. Repeat step 1 through step 3 for the Security Log and the System Log.

5. Close the Event Viewer page.

Installing the Empower 2 FR 5 client on the Citrix server
Restriction: Do not attempt to install the Empower 2 FR 5 client on the Citrix 
server from a staged network location. Install the client on the Citrix server 
using the Empower 2 FR 5 DVD from a local or mapped DVD drive.

To install the Empower client software

1. Access Add/Remove Programs from the Control Panel.

2. On the Add or Remove Programs page, click Add New Programs. Then 
click the CD or Floppy button.

3. Insert the Empower 2 FR 5 DVD into the DVD drive, and click Next on 
the Install Program From Floppy Disk or CD-ROM page.
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4. On the Run Installation Program page, click Browse and browse to the 
Client folder on the DVD. Select the EmpowerClientFR5setup.exe file, 
and then click Next.

5. On the Choose Setup Language page, select a language from the 
drop-down list, and then click OK.
Restriction: Do not click Next on the After Installation page until the 
installation is complete.
Requirement: If Microsoft .NET Framework 3.0 software is installed on 
your system, the installation continues. However, if the software is not 
installed, the Requirement wizard page appears. On that page, click 
Install.

6. On the Welcome page, click Next.

7. On the License Agreement page, accept the license agreement, and then 
click Next.

8. On the Customer Information page, enter your user name, organization, 
and serial number, and then click Next.

9. On the Setup Type page, leave Typical selected. 

10. Verify that the correct Empower Installation Type (Client) is selected, 
and then click Next.

11. On the Installation Options page, make the following selections:
In the TNS_ADMIN environment variable field, you have the option of 
setting the TNS_ADMIN environment variable. This variable setting 
adds an environmental variable to the client that points to a 
preconfigured tnsnames.ora file, which is located in a network-accessible 
share. This option allows large installations to maintain a single 
tnsnames.ora file in a share instead of configuring a tnsnames.ora file on 
each client and LAC/E32 module. 
� If you do not intend to use this configuration option, leave No 

selected, and then click Next.
� If you want to enable the TNS_ADMIN variable, select Yes, enter 

the network path to the share containing the preconfigured 
tnsnames.ora file (for example, \\servername\sharename$), and 
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then click Next. (Use the TNS_ADMIN directory that was set in 
�Configuring a shared tnsnames.ora file� on page 4-9.)
Rule: If the TNS_ADMIN environmental variable is set, the client 
disregards local tnsnames.ora files.

12. On the Ready to Install the Program page, click Install to start the 
installation.

13. When the installation is complete, click No on the Empower Client 
Installer Information page. DO NOT click Yes on this page.

14. On the After Installation page, click Next.

15. On the Finish Admin Install page, click Finish.

16. Restart the Citrix server, and log in to the operating system as an 
administrator.

Disabling WatersService
By default, WatersService is installed with the startup type set to automatic. 
If WatersService is left running, processing jobs will be queued rather than 
executed concurrently. This can cause slower performance.
Recommendation: For better performance, disable WatersService.

To disable WatersService

1. From the Start menu, right-click My Computer and select Manage.

2. Under Services and applications, double-click Services.

3. Right-click WatersServices, and then select Properties.

4. On the Properties page, change the Startup type to Disabled. Click 
Apply, and then click OK.

5. Restart the Citrix server.

Configuring the database net service names
To configure the database net service names, see �Configuring a database net 
service name� on page 6-9. On the Net Service Name page, remember that you 
must define the same net service name on both the Citrix server and the 
LAC/E32 modules.
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Publishing Empower in Citrix Presentation Server

To publish Empower in Citrix Presentation Server v4.0

1. Log in to the Citrix Management Console.

2. Select Actions > New > Published Application.

3. On the Publish Application page, enter a Display Name and an 
Application Description, and then click Next.

4. On the Specify what to Publish page, select Application and click 
Browse.

5. On the Choose Application page, double-click the appropriate Citrix 
server and locate X:\Empower\bin\empower.exe (where X is the drive 
on which you installed Empower). Click OK, and then click Next.

6. On the Program Neighborhood Settings page, select how you want the 
application to be launched, and then click Next. 
Tip: The typical setting is �Add shortcut to client�s desktop�.

7. On the Specify Applications Appearance page, select your session 
window size, set colors to True Color (24 bit), clear Maximize application 
at startup, and then click Next.

8. On the Specify ICA Client Requirements page, click Next.

9. On the Specify Application Limits page, click Next.

10. On the Specify Servers page, select the Citrix servers that the 
application will run on, and then click Next.
Tip: If you have multiple Citrix servers in a farm, and you want to 
publish Empower 2 FR 5 as a load-balanced application, add each server 
that has the Empower Client Stack installed to the Configured Servers 
list. 

11. Select the appropriate domain from the Look in list, then select the 
accounts that will have access to the application, and then click Add.
Requirement: For multiple domains, click the folder icon located to the 
right of the Look in list. Select the next Domain, and repeat this step.

12. Click Next after all accounts have been configured.

13. Click Finish to exit the Citrix Management Console.
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Tip: If you are using multiple databases and multiple Citrix servers 
configured in a server farm, you can configure roaming profiles to ensure that 
each Windows user�s default database is set correctly. The last database a 
user successfully logged in to is the default database.

To publish Empower in Citrix Presentation Server v4.5

1. Log in to the Citrix Access Management Console.

2. On the Citrix Access Management Console, under Citrix Resources:

a. Click Presentation Server.

b. Select the Citrix Server Farm (or the Applications folder or any 
subfolder). 

c. From the Action menu, click New > Publish Application.

3. At the Welcome Screen, click Next.

4. At the Name screen, enter a Display Name and an Application 
Description, and then click Next.

5. At the Type screen: 

a. Click Application. 

b. For Application type, select �Accessed from a server�.

c. For Server application type, select Installed Application.

d. Click Next.

6. At the Location Screen:

a. On the Command line dialogue box, click Browse to locate the 
X:\empower\Bin\Empower.exe file (where X: is the drive where 
Empower is installed).
Result: The Working Directory defaults to the directory selected in 
the Command Line box.

b. Click Next.

7. At the Servers screen:

a. Click Add. 

b. Select the server on which your published application will run, and 
then click Add. 
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c. Click OK.

d. Click Next.

8. At the Users screen:

a. Select �Allow only configured users�.

b. In the Select directory type, select �Citrix User Selector� from the 
drop-down menu, and then click Add.

c. Select the Show Users checkbox. 

d. Double-click the appropriate domain. If prompted, enter a User 
Name and password to connect to the domain. 

e. Select the accounts that will have access to the application, and 
then click Add.

f. Click OK to close the window, and then click Next.

9. At the Shortcut presentation screen, select the checkbox for �Add 
shortcut to the client�s desktop�, and then click Next.

10. At the Publish Immediately Screen, select the checkbox for �Configure 
advanced application settings now�.

11. At the Access Control screen, accept the defaults, and then click Next.

12. At the Content redirection screen, accept the defaults, and then click 
Next.

13. At the Limits screen, accept the defaults, and then click Next.

14. At the Client options screen, accept the defaults, and then click Next.

15. At the Appearance Screen, select your session window size and set the 
Colors to True color (24-bit).
Tip: Ensure that �Maximize application at startup� is not checked.

16. Click Finish to exit the Citrix Management Console.

Checking for Empower service packs

Waters periodically releases service packs to address existing issues or to 
provide enhanced functionality. These service packs are available for 
downloading from the Waters Elite web site and should be installed according 
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to the instructions contained in their associated release notes. If you want 
physical media, note the part number from the web site and contact your local 
Waters subsidiary to place an order.
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A Connecting remotely to a 
LAC/E32 module

This appendix explains how to configure remote connections to LAC/E32 
modules.
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Connecting to LAC/E32 modules

The LAC/E32 module has Remote Desktop Connection administration software 
installed on it. The software is installed by default during Windows XP 
installation. If you have an XP system, use the Remote Desktop application to 
control the LAC/E32 module remotely.
This appendix explains how to install remote administration software on a 
viewer client or server computer. The preferred method for remote control is to 
use Remote Desktop Connection.

Configuring Remote Desktop Connection

Requirement: For Remote Desktop Connection to work, both the Client 
Viewer computer and the Remote Host computer must have the TCP/IP 
Protocol installed on the network connection, and there must be a TCP/IP 
address assigned.

To configure Remote Desktop Connection software

1. Click Programs > Accessories > Communications > Remote Desktop 
Connection.

2. In the Remote Desktop Connection page, click Options.
If you want Remote Desktop Connection to start without the need to 
enter an administrator password, type the Administrator password in 
the password box, and select Save my password.

Tip: The LAC/E32 is shipped from Waters with the Administrator 
password set to �waters�.

3. Click the Local Resources tab and perform these actions:
� In the Remote computer sound selection box, select �Do not play�.
� In the Keyboard selection box, select �In full screen mode only�.
� In the Local devices box, clear these check boxes: Disk drives, 

Printers, and Serial ports.

4. Click the Experience tab. In the �Allow the following� check box list, 
clear Desktop background, and select all the remaining options.

5. Click the General tab.
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6. To save all these settings, in the Connection settings box, click Save As.
Tips: 
If you want to keep these as the default settings for starting Remote 
Desktop Connection, then allow them to be saved in the default settings 
file named Default.rdp.
Different settings can be saved with different file names and then 
selected with the Open button in the General page. When you save the 
Remote Desktop configuration settings file to a filename that already 
exists, a warning message appears. Click Yes to replace the file.

To start a Remote Desktop connection

In the Remote Desktop Connection General tab, type the IP address of the 
remote LAC/E32 module into the Computer box, and then click Connect.
Alternative: If the Viewer client and the Remote LAC/E32 are configured in the 
same domain using the same IP address range and Subnet mask, you can 
connect to the remote LAC/E32 module using the remote system�s computer 
name.
Tip: The Windows XP LAC/E32 is shipped from Waters with an IP address of 
10.10.10.xxx, and a computer name of Waters-xxx, where xxx are the last 3 
numeric digits of the Waters LAC/E32 serial number. For example, for Waters 
Serial Number E02L32105W, the IP address would be 10.10.10.105, and the 
computer name would be Waters-105. 
Exception: If the computer is not found, an error message appears. If the 
computer name was used to connect to the computer, then try again using the 
IP address. Connecting using the IP address should always work.
Keep these items in mind when working with Remote Desktop Connection:

� If you select �Browse for more� in the list of available computers, the 
network browse page appears. If you double-click to continue the 
browse, an error message appears if no terminal server is installed on 
your network.

� In full screen mode, a connection bar appears at the top of the remote 
LAC/E32 Host screen. (The host computer is called the remote computer 
in Remote Desktop Connection terminology.)
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The connection bar has the remote computer name or IP address that 
you entered, so it shows which LAC/E32 module you are remotely 
controlling. In addition, the connection bar offers the following controls:
� Minimize button (-) � Minimizes the remote host desktop and 

returns you to the viewer computer desktop with the remote host 
session minimized on the task bar.

� Close button (x) � Disconnects the remote host session. You can also 
disconnect from the remote host by clicking Start > Disconnect.

� Restore/Maximize button � Allows the remote host desktop be a 
window on the viewer computer desktop. When the remote desktop 
is a window, the Connection bar is no longer necessary and is no 
longer displayed.

� If you change the IP address at the remote LAC/E32 module during a 
remote connection session, and then click the OK button in Local Area 
Connection Properties, immediately issue a session Disconnect. You can 
then reestablish the connection using the new IP address for the 
computer name (or the computer name if the systems are now in the 
same domain/IP address range/subnet mask).

� To disconnect from the remote system yet keep your logon session active, 
click the �x� on the connection bar in full-screen mode. Alternatively, at 
the remote system desktop, click Start > Disconnect. The Disconnect 
Windows Session message box appears. Click OK.

When you disconnect from the LAC/E32, the remote session is still active 
and you are still actively logged on to the system. If you want to end your 
remote session, you must log off from the system.

� To log off and end a remote session, at the remote system desktop, click 
Start > Log Off. The Log Off Windows page appears. Click the Log Off 
Button. The LAC/E32 module shows the logon screen, ready to initiate 
another Remote Desktop Connection session.

Tip: Empower 2 FR 5 services will run on the LAC/E32 while it is at the 
logon screen.

If a system restart occurs at the remote host during a remote session, (for 
example, after a program installation and restart) you are automatically 
logged off from the remote system and returned to the viewer desktop. 
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To initiate a system Restart or Power-down

1. Click Start > Windows Security. 
Tip: This will bring up the same menu as pressing Control > Alt > Delete 
at the LAC/E32 Desktop with local logon.

2. Click the Shutdown button. 
Tip: This will bring up the Shut Down Windows page. 
Select Restart or Shutdown and then click OK.

Configuring LAC/E32 modules to accept remote 
connection

For the Windows XP LAC/E32 module to accept incoming remote connections, 
it must be enabled in System Properties. Enabling of the Windows XP 
LAC/E32 module has already been accomplished.
If for any reason, the configuration is lost, perform these actions to restore the 
capability to accept remote connections.

To configure LAC/E32 modules to accept remote connections

1. Right click the My Computer Icon on the desktop and select Properties.

2. Click the Remote tab. 

3. Select the �Allow users to connect remotely to this computer� check box, 
and click OK.

System administrators can use Remote Desktop Connection by default. 
However, it is possible to Add other users or Groups with this capability using 
the Select Remote Users button in the Remote tab of the System Properties 
page on the LAC/E32 module.
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